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ED I TO RI AL

This magazine was created using :

WELCOME TO ANOTHER ISSUE OF FULL CIRCLE.

N

o Python this month I'm afraid, so I'm filling in with an article on how to get Android
apps running in your *buntu distro using the Arc Welder extension for Chrome. It works
surprisingly well, but only in Chrome browser. We still have LibreOffice, another LaTeX
article and more JavaScript.
If you've got WiFi problems in your abode and would even settle for a network point then
have a read of my Linux Labs article where I explain how I set up a remote IP camera using a
pair of powerpoint plugs. I bought them thinking they'd never work properly, or not be
sufficient, but they're surprisingly good!
Long time readers will know that I'm a KDE man. Sure, I've fallen off the wagon a few
times (*cough* 4.0 *cough*), but I've always returned when it's at its best. Well, the KDE
team has been busy updating the Plasma backend of KDE to version 5. It really is a thing of
beauty. Alan Ward has sent in a review of Plasma 5 for you to read through. If you haven't
tried KDE (or just haven't tried it in a while) please do. It's criminally under-rated in my
opinion. Plasma 5 is now the standard in Kubuntu as of 1 5.04, so you've no excuse!
I'm still thinking of things to do for FCM#1 00. If you've any suggestions or, better still,
articles that are a bit different from the norm then send them to:
ronnie@fullcirclemagazine.org.

Full Circle Podcast

Released monthly, each episode
covers all the latest Ubuntu news,
opinions, reviews, interviews and
listener feedback. The Side-Pod is
a new addition, it's an extra
(irregular) short-form podcast
which is intended to be a branch
of the main podcast. It's
somewhere to put all the general
technology and non-Ubuntu stuff
that doesn’t fit in the main
podcast.

Hosts:

• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark

All the best, and keep in touch!
Ronnie
ronnie@fullcirclemagazine.org

http://fullcirclemagazine.org
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SPAM -BLASTING MALWARE
INFECTS THOUSANDS OF
LINUX AND FREEBSD
SERVERS

FCM#1 00
SURVEY
The question is:

What are your most
loved/hated flavors and
releases?
Take the quick survey and we'll
publish the results in
FCM#1 00.

http://goo.gl/DPt2q0

S

spam botnet made up of 1 0,000
Linux servers that Eset discovered
1 4 months ago.
Source:
http://arstechnica.com/security/20
1 5/04/30/spam-blasting-malwareinfects-thousands-of-linux-andfreebsd-servers/
Submitted by: ArnfriedWalbrecht

everal thousand computers
running the Linux and FreeBSD
operating systems have been
infected over the past seven
months with sophisticated malware
that surreptitiously makes them
part of a renegade network
APPLE, LINUX DEVICES TO BE
blasting the Internet with spam,
DECODED AT NEW CBI LAB
researchers said Wednesday. The
malware likely infected many more
he Indian Central Bureau of
machines during the five years it's
Investigation has got a new
known to have existed.
specialized forensic lab to decipher
and recover data from Apple
Most of the machines infected
devices seized from suspects
by the so-called Mumblehard
during investigation of cases. The
malware are believed to run
new lab, inaugurated at the CBI
websites, according to the 23-page academy in Ghaziabad, will be fully
report issued by researchers from
equipped with the latest
antivirus provider Eset. During the workstations and software to
seven months that they monitored decode the digital information
one of its command and control
stored in Apple devices, said
channels, 8,867 unique IP
sources.
addresses connected to it, with
3,000 of them joining in the past
So far, the agency had
three weeks. The discovery is
limitations in deciphering Apple
reminiscent of Windigo, a separate
full circle magazine #97
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and Linux-based devices, which are
becoming extremely popular
nowadays, with the training of
forensic experts emphasizing
Windows-based software.
The specialized lab is focused on
extracting information from Apple
devices, using forensic software,
from devices such as the iMac,
MacBook Pro, iPad, iPhone and
iPods as well as from Linux devices
which are like Android-based
devices. The laboratory has been
given forensic tools for cloning,
imaging, password recovery,
forensic analysis and internet
artifact recovery to enable speedy
probes, said an official.
Source:
http://timesofindia.indiatimes.com/
tech/tech-news/Apple-Linuxdevices-to-be-decoded-at-new-CBIlab/articleshow/471 27838.cms
Submitted by: ArnfriedWalbrecht
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HP' S U BUNTU 1 4.04

when you connect an external
EIGHT LINUX SECURITY
display, mouse and keyboard. That
doesn’t just mean that you can run I MPROVEMENTS I N E IGHT
YEARS
smartphone apps blown up for a
big screen: you’ll be able to use
n 2007, Andrew Morton, a noUniversal Windows apps which will
nonsense colleague of Linus
All three of HP’s efforts are
change their look and feel for large
based on AMD’s under-rated quad- screens and the operating system Torvalds known as the "colonel of
the kernel," called for developers
core A4/8/1 0 processors coupled
will look different on TVs too.
to spend time removing defects
to 4GB or 8GB of RAM and 1 TB
and vulnerabilities. "I would like to
hard drives, on a traditional 1 5.4
But Microsoft wasn’t the first
inch laptop platform. They are
company with this idea: Canonical’s see people spend more time fixing
bugs and less time on new
cheap by PC standards, starting at been working on bringing similar
features. That's my personal
£1 99, £249, and even the £300
features to Ubuntu for years. A
asking price for the top-of-thefew years ago the company tried to opinion," he said in an interview at
the time.
range HP455 represents
raise $32 million through
outstanding value for money.
crowdfunding to build an Ubuntu
So how's that going? Since
smartphone that could work as a
Source:
desktop… but the company didn’t Morton issued his call, Linux has
added several million lines of code
http://www.techworld.com/blog/w meet its goals.
and many thousands of patches
ar-on-error/hps-new-ubuntu-1 404and new features. The Linux kernel
laptops-offer-workstation-onNow Ubuntu founder Mark
budget-performance-361 0629/
Shuttleworth says someone else is development process has shown
Submitted by: ArnfriedWalbrecht building one, and it’s set to launch marked improvement on the
security front. It was as good as, or
in 201 5.
better than, most commercial code
when Morton issued his 2007
Source:
5/05/ubu challenge. As InformationWeek
U BUNTU PHONE THAT WORKS https://liliputing.com/201
checked into its defect-fixing
ntu-phone-that-works-as-aAS A DESKTOP PC COMING IN desktop-pc-coming-in-201 5.html
record, it was surprising how many
gains have been made in the last
Submitted
by:
ArnfriedWalbrecht
201 5
three years.
icrosoft recently announced
Linux is better than most
that upcoming Windows
commercial
code. For example,
Phone devices would be able to
where one defect per 1 ,000 lines
operate like desktop computers
full circle magazine #97
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support which is essential for
smaller organisations not inclined
LAPTOPS OFFER
to tend their own systems should
WORKSTATION -ON -A-BUDGET something go wrong. This is the
grown-up way to do things.
PERFORMANCE

I

t’s a small but symbolic boost
but the Linux section of the UK
online website eBuyer is suddenly
looking more populated with the
announcement last week by HP of
three laptops pre-loaded with last
year’s Ubuntu 1 4.04 (Trusty Tahr)
LTS.
They’re not the first Linux or
Ubuntu laptops to be sold on the
site by a long shot; an entry-level
HP appeared on the site over a
year ago and that’s before
factoring in the Thinkpads already
on offer from Lenovo. But while
pre-loaded Ubuntu has been
around for ages, these machines
appear to be aimed at a more
mainstream buyer than the wellestablished developer niche.
Anyone can, in principle, load
Ubuntu on the similar hardware,
but buying pre-configured
hardware has important
advantages. Everything is
guaranteed to work without issue,
and then there’s the matter of

M

I
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of code is considered quality, Linux
in July 201 4 had .55 defects per
1 ,000 lines. Linux also is better
than most other open source
projects. That didn't happen
overnight, and it didn't happen
without changes to the kernel
process. What has happened with
Linux should serve as a standard by
which other projects are
measured. As concern grows about
the security and maintainability of
open source code in the Internet's
infrastructure, there may be
lessons to be learned from Linux's
example.

being the key three. Twistlock aims
to solve the last of those and be
part of unlocking far-broader
container adoption.

http://www.forbes.com/sites/benk (UEFI), the replacement for the
motherboard firmware or BIOS.
epes/201 5/05/07/twistlocklaunches-to-solve-linux-containerThe three main Linux
security-problems/
Submitted by: ArnfriedWalbrecht companies Red Hat, SUSE, and
Containers are, of course, a
Canonical — the last-named being
Linux concept that allows the
the parent firm of the Ubuntu
running of multiple isolated Linux M ICROSOFT' S NEW SECURE
distribution — have each devised
systems on a single control host.
ways to support secure boot. While
BOOT
STRATEGY
WILL
SUIT
With Linux containers (instead of
some other distributions also do
creating a full virtual environment) LINUX FIRMS
so, using the same code as that
an operating system is shared
used by these three, many do not.
across the various containers while
icrosoft made its intentions
running resources are offered to
Thus, if it was impossible to
known during its WinHEC
each container in isolation. Linux
turn
off secure boot on a PC, and
conference in Shenzhen, China, in
containers have existed for a long March, when it announced that, in one wanted to install Linux on it,
time, but Docker reinvigorated the the case of hardware that was
then the only option would be to
notion and brought it to a wider
Source:
use a distribution that supported
installed with Windows 1 0, it
http://www.informationweek.com/ audience.
secure boot.
would be leaving the choice of
software/enterprisehaving a means to turn off secure
As Docker has made container
applications/8-linux-securitySource:
boot up to the vendor.
usage more prevalent, it has,
improvements-in-8-years/d/dhttp://www.itwire.com/opinionhowever, also highlighted some
id/1 320294
and-analysis/open-sauce/67959When secure boot was
Submitted by: ArnfriedWalbrecht issues with Linux containers that
microsofts-new-secure-bootintroduced by Microsoft, along
make even broader adoption
strategy-will-suit-linux-firms
with Windows 8, ostensibly as a
difficult – storage, networking, and means to improve security, it
Submitted by: ArnfriedWalbrecht
security
being
the
three
most
that OEMs had to
TWISTLOCK LAUNCHES TO regularly cited examples. Indeed, mandated
provide a means for turning it off
SOLVE LINUX CONTAINER
much of the justification for
on the x86 platform. It could not
TEN OF THE BEST LINUX
vendors suggesting that containers do otherwise as it has in the past
SECURITY PROBLEMS
DISTROS FOR PRIVACY FIENDS
should still be run within a virtual
been convicted of monopolistic
s the idea of containers gains machine relate to the security
AND SECURITY BUFFS
trade practices.
issue.
momentum, there are a
couple of problems that
inux distributions can be
Secure boot is a part of the
increasingly need to be solved –
separated into various
specification for the Unified
networking, storage, and security Source:
categories based on use case and
Extensible Firmware Interface
full circle magazine #97
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the intended target group. Server,
education, games and multimedia
are some of the most popular
categories of Linux distros.

Submitted by: ArnfriedWalbrecht

WILL $9 LINUX CHIP
REPLACE RASPBERRY PI ?

For security conscious users,
however, there's a growing niche
echnology startup Next Thing
of distros aimed at protecting your
is preparing to unleash a credit
privacy. These distros help ensure
you don't leave a digital footprint card-sized personal computer -dubbed CHIP -- on the world,
as you go about navigating the
turning to the crowdfunding site
web.
Kickstarter to drum up financial
However, for the truly paranoid, support.
privacy distros are only one part of
The project, which has already
the equation - and the greater part
received close to $700,000 out of a
of that equation involves
penetration testing distros. These $50,000 goal with 26 days to go,
are distros designed for analysing allows users to work in LibreOffice,
a free and open source office suite
and evaluating network and
developed by The Document
system security. These efforts
Foundation that allows users to
feature a vast array of forensic
save documents to CHIP's onboard
tools to help you test your
storage.
configured systems for potential
weaknesses.
The basic CHIP costs just $9,
with
a battery, VGA and HDMI
In this article, we've highlighted
adapter, and mobile casing, which
1 0 of the best privacy and pen
can eventually push the price up to
testing distros.
just under $50.
Source:
CHIP is expected to ship in
http://www.in.techradar.com/news
/software/security-software/1 0-of- December of this year, with the full
the-best-Linux-distros-for-privacy- package with accessories available
in May of next year.
fiends-and-securitybuffs/articleshow/4721 1 893.cms
full circle magazine #97
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STEALTHY LINUX GPU

trying to highlight lies not with the
operating systems, such as
Windows or Linux, nor with the
GPU (graphics processor unit)
vendors, but rather with existing
security tools, which aren’t
designed to scan the random
access memory (RAM) used by
GPUs for malware code.

A

Source:
http://www.pcworld.com/article/2
921 092/gpu-malware-can-alsoaffect-windows-pcs-possiblymacs.html
Submitted by: ArnfriedWalbrecht

Source:
http://www.informationweek.com/
it-life/will-$9-linux-chip-replaceraspberry-pi/d/d-id/1 320359
Submitted by: ArnfriedWalbrecht

MALWARE CAN ALSO HIDE IN
WINDOWS PCS, MAYBE
M ACS
team of anonymous
developers who recently
created a Linux rootkit that runs
on graphics cards has released a
new proof-of-concept malware
program that does the same on
Windows. A Mac OS X
implementation is also in the
works.

E

very so often I get the
pleasure of writing a review
where the biggest challenge is
finding something, anything, to
nitpick in order to ensure I don’t
sound like I’ve been bought off by
the company. Such is the case with
the Meerkat, by System76. A small
device that, at first blush, one
might think is a toy. I can assure
you, this 4.5” by 4.5” device
The problem the developers are performs with the power of a
machine three or four times its

The developers are trying to
raise awareness that malware can
infect GPUs and that the security
industry is not ready for it. Their
goal isn’t to tip off malicious
hackers, but the source code they
released, while incomplete and
buggy by design, could potentially
be built upon and used for illegal
purposes.

7

SYSTEM 76 M EERKAT: THE
PERFECT M INI PC FOR
M ULTIMEDIA OR D ESKTOP
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size.

The Meerkat greeted me with
Ubuntu 1 5.04. I immediately set
about tweaking the device to fit
my tastes and needs. The first
step: installing my usual lineup of
software. As soon as I began the
process, I fell in love with the
device. The Meerkat is fast …
much faster than a device this size
should be.

U BUNTU JUMPS INTO
I NTERNET OF THINGS WITH
ACER, GE, AND M ICROSOFT

Y

es, you read the headline
correctly. Microsoft and
Canonical are partnering up on IoT.

Source:
http://www.zdnet.com/article/ubu
ntu-jumps-into-internet-of-thingswith-acer-ge-andmicrosoft/#ftag=RSSbaffb68
Submitted by: Steven J. VaughanNichols

Old enemies are becoming new U BUNTU 1 5.04 HANDS -ON :
allies as technology shifts from the O NE GIANT LEAP FOR
PC/desktop model to first mobile
DEVELOPERS AND THE
computing
and
now
the
Internet
of
I moved the Meerkat over to my Things (IoT). Canonical, Ubuntu
CLOUD, BUT ONE SMALL STEP
60” LED television, sat on the
parent company, is
FOR THE DESKTOP
couch, and turned the tiny PC into Linux's
partnering
with
Acer,
DataArt,
and
the ideal multimedia device.
Microsoft.
here are lots of new goodies in
Netflix? No problem. Spotify? I
Ubuntu 1 5.04, Vivid Vervet,
think I will. Youtube? Yes please.
That
wasn't
a
typo.
Canonical
but
most
of them are for cloud
The Meerkat handled anything and and Microsoft, which were already
administrators and DevOps.
everything I could give it without a working together on bringing
Ordinary Ubuntu PC users will find
single hiccup. Even rendering a
Canonical's
Juju
DevOps
tools
to
only a slightly better desktop
video in OpenShot was blazingly
Windows
and
bringing
Windows
experience.
fast. And because the connection
Server
to
OpenStack,
are
working
to the TV was handled via mini
DataArt on an IoT industrial
In this release, the distribution
HDMI to HDMI, there was no need with
predictive
maintenance
solution.
It
boasts a new light-weight snappy
to run a second cable for sound.
will
combine
the
three
companies'
Ubuntu Core version for devices,
It’s all there and it’s all good.
IoT, cloud, big data, machine
micro-servers, and containers. It
learning,
and
Docker
efforts.
To
also includes updated developer
Source:
integrate
all
of
this
they'll
be
using
http://www.linux.com/news/hardw "Snappy" Ubuntu apps, DeviceHive, tools and the latest frameworks,
languages, databases and
are/desktops/829053-system76and
Juju
Charms.
Microsoft
will
packages. This cloud brand of
meerkat-the-perfect-mini-pc-foralso
use
an
Azure
service
to
Ubuntu also comes with superior
multimedia-or-desktop
manage
and
capture
machine
data.
Docker support, Canonical's own
Submitted by: JackWallen
new container-based hypervisor,
full circle magazine #97
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LXD, and built-in support for the
Chef DevOps program.
The rest of the Ubuntu
desktop's interface, powered by
Unity 7.3, looks and acts the same.
So, for example, you can use the
HUD to search for programs and
files no matter where they may be
located on your system.
Source:
http://www.zdnet.com/article/han
ds-on-with-ubuntu-1 5-04/
Submitted by: Steven J. VaughanNichols

U BUNTU LXD: N OT A
D OCKER REPLACEMENT, A
D OCKER ENHANCEMENT

S

ometimes it seems that
Canonical, Ubuntu's parent
company, can't win for losing.
Often accused of trying to force
other open-source groups to
follow their lead by keeping
projects internal until they feel it's
ready to be shared with others,
when Ubuntu announced its
intention to build LXD, a
hypervisor for containers, at the
OpenStack Summit, the company
was immediately accused of
contents ^
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announcing vaporware (!), of
shoving LXD down other
programmers' throats, and of
trying to replace Docker.
On the technical side, LXD,
pronounced Lex-Dee, is an
expansion of LXC, the Linux
container technology behind
Docker. Specifically, according to
Stéphane Graber, an Ubuntu
project engineer, LXD is a "daemon
exporting an authenticated
representational state transfer
application programming interface
(REST API) both locally over a unix
socket and over the network using
https. There are then two clients
for this daemon, one is an
OpenStack plugin, the other a
standalone command line tool."
Source:
http://www.zdnet.com/article/ubu
ntu-lxd-not-a-docker-replacementa-docker-enhancement/
Submitted by: Steven J. VaughanNichols

U BUNTU CORE D RONE I S
THE FIRST D RONE THAT H AS
APPS

T

480826.shtml
Submitted by: Silviu Stahie

O PEN SOURCE HAS TO BE

he world is changing, and it
looks like everything will soon MORE THAN LINUX
be powered by operating systems
hile the notion of free
and apps, and that includes drones,
software has lasted since
as unlikely as it might sound.
the days Richard Stallman was
The Erle-Copter was presented sleeping under his desk at MIT, the
a couple of weeks ago, but now its full thrust of collaboratively and
openly licensed software really
makers have returned with more
details about this amazing piece of took off with the advent of Linux.
technology. This is not the average
Linux took a principle and filled
drone you can get at your mall and
that can do basically three things, in an important technology gap
fly, crash into walls, and break. It's that inspired the filling of a
what you might call a smart drone, thousand other gaps too. This led
to the rise of the venerable Linux
and it's powered by Ubuntu core.
distribution, as myriad as
consumer-grade platforms such as
To make things even more
Ubuntu and Fedora, to serverinteresting, it's a drone that's
powered by Ubuntu Core and apps, grade such as CentOS and Debian,
and down to the downright weird
which is quite weird if you think
such as RebeccaBlackOS.
about it. On the other hand, the
makers of this drone do need to
For those of us born in the brine
program it and run various
of Linux, openness and a
"behaviors" on it. The Ubuntu OS
commitment to living and
was the perfect choice.
breathing openness have always
been common social components.
Source:
http://news.softpedia.com/news/U It is not uncommon in the Linux
world to use a Linux distribution
buntu-Core-Drone-Is-the-Firstand entirely open source
Drone-That-Has-Appsfull circle magazine #97
9
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applications with a few exceptions,
such as Skype and Steam.
Despite some rather
remarkable projects, desktop Linux
has always struggled to get a hold
of the market, hovering at around
1 .5% of overall market share.
While the server, cloud, and
infrastructure siblings to the Linux
desktop have gone on to
dominate, the desktop has been
lagging behind, despite passionate
and high-quality efforts from
projects such GNOME, KDE,
Elementary, and many others.
Source:
http://opensource.com/life/1 5/5/o
pen-source-has-be-more-linux
Submitted by: ArnfriedWalbrecht

SNAPPY U BUNTU LINUX
N OW U SED IN N ETWORKING ,
REFRIGERATORS

C

anonical, the lead commercial
sponsor behind the opensource Ubuntu Linux operating
system, today announced an
expansion of its push to embed
Linux in everything from phones to
refrigerators—and now network
switches. The Snappy Ubuntu Core
contents ^
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Linux operating system, a minimal
version of Ubuntu Linux that
provides an improved updating
and security model, is designed for
embedded devices and the
Internet of things (IoT). Snappy
was first announced in December
201 4 and became generally
available with the Ubuntu 1 5.04
Vivid Vervet release on April 23. To
date, Canonical has positioned
Snappy as a platform for the cloud
and mobile devices and is now
bringing it to Open Compute
Platform (OCP) network switches.
The OCP networking effort kicked
off in 201 3 as a way to enable an
organization to choose the
operating system they want to run
on an open networking switch.
"Switches to us are important and
very strategic," Dustin Kirkland,
product manager at Canonical, told
eWEEK. "There is switch at the top
of every rack in every data center."
Source:
http://www.eweek.com/networkin
g/snappy-ubuntu-linux-now-usedin-networking-refrigerators.html
Submitted by: ArnfriedWalbrecht

SOLAR S AIL SPACECRAFT
RUNS LINUX AND U SES SSH,
S AYS B ILL N YE

T

he idea of solar sails was first
introduced in popular culture
by none other than Carl Sagan,
more than 40 years ago. This
particular technology was not a
priority for scientists in the past
decades, with very few exceptions,
but The Planetary Society and Bill
Nye want to change that by
launching a small spacecraft called
CubeSat that will be powered by
light.
The principle behind the
technology is quite simple. The
light particles, the photons, don't
have any mass, but they do have a
lot of energy. The spacecraft
deploys a large solar sail, which is
bombarded with light. The
acceleration is very small, but
constant, which means that a
spacecraft can achieve great speed
in a relatively short amount of
time. Even if this particular piece of
information is not available on the
Kickstarter page, it was revealed in
an AMA session on Reddit, which
was held by Bill Nye himself. To
make things even more interesting,
he also said that it would be
full circle magazine #97

possible to SSH into the spacecraft. the Tor browser alone on a typical
operating system. How effective is
"The software is Linux-based. I
this concealment-centric operating
just recently learnedthat, providing system’s tools? Well, in 201 2,
we have a stable link, we can
vulnerabilities for Tails topped the
actually SSH into the spacecraft,
NSA’s most-wanted list alongside
which I findvery cool. The control
Tor and TrueCrypt.

sequences are automated. There are
sun sensors that locate the sun and
Let’s dig into Tails’ basic
tack basedon that," said Bill Nye on capabilities, as well as the new
Reddit.

changes.

Source:
http://news.softpedia.com/news/S
olar-Sail-Spacecraft-Runs-Linuxand-Uses-SSH-Says-Bill-Bye481 089.shtml
Submitted by: ArnfriedWalbrecht

Tails stands for “The Amnesiac
Incognito Live System,” and it’s
designed to be booted and run
entirely from a disc, USB drive, or
SD card. This ensures no traces of
your activity are written to your
PC’s hard drive. It also means any
malware or other surveillance
software running on a computer’s
normal operating
system—Windows, for
example—won’t be involved with
the Tails session.

TAILS 1 .4 POLISHES UP THE
PRIVACY-OBSESSED LINUX
OS TRUSTED BY EDWARD
SNOWDEN

T

ails, a privacy and anonymityfocused Linux distribution
most famously used by Edward
Snowden, just released version 1 .4.
This Debian-based system is
designed to preserve your privacy
and anonymity online, providing
better protection than just using

10

Source:
http://www.pcworld.com/article/2
92301 3/tails-1 4-polishes-up-theprivacy-obsessed-linux-os-trustedby-edward-snowden.html
Submitted by: ArnfriedWalbrecht
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M EIZU WILL SELL U BUNTU
MX4 ACROSS EUROPE
SOON , S AYS CANONICAL

H

owever, the sad news for
many of us who wanted to
purchase the Ubuntu-powered
device from Meizu is that the
Ubuntu MX4 smartphone is sold
only in China for the time being,
despite the fact that Meizu said a
few months ago that it would sell
it internationally.

Europe-Soon-Says-Canonical481 404.shtml
Submitted by: ArnfriedWalbrecht

SERIOUS RED H AT LINUX
B UG AFFECTS H ASWELLBASED S ERVERS

A

recent post by Gil Tene raises
the importance of an
important, little known patch to
Linux kernels that should be
reviewed by all users and
According to Canonical, the
administrators of Linux systems,
Meizu MX4 Ubuntu Edition
especially those who utilize
smartphone will come to the
Haswell processors. Tene reports
European market soon, but today's that in particular users of Red Hatannouncement says nothing about based distributions (including
the device being sold in the US or
CentOS 6.6 and Scientific Linux 6.6)
another continent anytime soon.
should apply the patch as soon as
Also, the phone appears to be
possible. Even if your instance of
targeted at Ubuntu Touch
Linux is running in a VM, that VM is
developers at the moment.
most likely hosted on a Haswell
machine if is on the popular cloud
"In the first ofa series of
providers (Azure / Amazon /etc)
launches, Meizu has announcedthat and would benefit from the patch.

the Ubuntu MX4, which will be sold
across Europe soon, is immediately
available to developers in China,"
says Canonical.

Source:
http://linux.softpedia.com/blog/M
eizu-Will-Sell-Ubuntu-MX4-Across-

Tene goes on to explain how
the flawed code performed (boils
down to a switch block missing a
default case). The big reason for
the problem today is that while the
code in question was fixed in
January 201 4, the flaw was
full circle magazine #97

backported into the Red Hat 6.6
family around October 201 4.
Other systems including (SLES,
Ubuntu, Debian, etc) are also
probably affected.
The fix for those systems is only
now being distributed and it could
be overlooked. Red Hat users
should look for RHEL 6.6.z or
newer. A key point made by Tene
is that the fix has been unevenly
distributed as different
distributions make specific choices
on what goes into their kernel.
Source:
http://www.infoq.com/news/201 5/
05/redhat-futex
Submitted by: ArnfriedWalbrecht
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M e te o r

Written by Lucas Westermann

O

ver the past year, I’ve written
a number of C&C articles
touching on web development
(from JavaScript frameworks, to
CSS preprocessors). Surprisingly, I
have received a relatively large
number of emails indicating an
interest in this topic. Due to this
interest, I wanted to spend this
month covering Meteor, which is a
relatively unique JavaScript
platform, and has also been the
focus of my own learning for the
last 5 or so weeks.

WHAT IS SO UNIQUE ABOUT
M ETEOR?

Cordova and Phonegap, meaning
you can easily create native
Android and iOS apps from the
finished web app. The nature of
the platform is to be reactive
(changes are seen instantly,
without a refresh - similar to
AngularJS), and offers plenty of
useful features. To find out more,
check out their website (link in
Further Reading).

will at least see the majority of the
normal HTML, even if it’s not very
pretty. In this day and age, the
question is simply how many
visitors will have disabled
JavaScript. In the matter of SEO Google definitely updated their
bots for JavaScript pages, but I’m
unsure of Yahoo or Bing. Checking
this before developing might be
useful.

WHAT ABOUT THE
DOWNSIDES?

That being said, there is a
plugin called Spiderable that uses
PhantomJS to create static HTML,
and send it to spiders (search
engine crawlers). Perhaps this
approach could be adapted for
visitors with javascript disabled,
though it does not appear to have
been attempted anywhere.

As both the server-side and
client-side are JavaScript, the page
will render absolutely nothing if
the browser has JavaScript
Meteor is unique in the fact
disabled. You could output some
that it is both a JavaScript server
(like NodeJS), but also ties into the sort of notice using a set of
<noscript> tags in the html’s
client side, so the application you
write exists on both the server and <head> tags, but if ostracizing
anyone who has JavaScript
the client. This brings with it an
disabled doesn’t work for you,
array of performance
enhancements, and some security Meteor will not be for you (at least,
not without various hacks, if it’s
concerns (which can generally be
avoided by following Meteor’s best even possible). That’s the benefit
to something like Angular practices).
depending on how you use it,
It’s also deeply integrated with visitors who don’t allow JavaScript
full circle magazine #97

WHEN SHOULD I USE
M ETEOR?
Technically, you can use Meteor
at any time. However, most of the
plugins and sites I’ve seen that use
Meteor are geared at heavy
interactive sites or complete web
applications. If you’re planning on
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creating a small static or semistatic web page, you may want to
carefully weigh the pros and cons.
That being said, Meteor’s own
page is naturally created in
Meteor.
Depending also on what tools
you’ve currently been using - Ruby
on Rails, or Node.JS, switching to
Meteor may be a welcome tradeoff, as development with Meteor is
extremely quick.

I’M INTRIGUED - WHERE CAN I
LEARN MORE?
The Meteor homepage has a
nice tutorial for getting started.
There are also various tutorials on
YouTube and the web. If you’re
looking for books, I can
recommend Discover Meteor (by
Tom Coleman and Sacha Greif),
whose authors are both active
Meteor developers.
Hopefully this article will be
helpful to some - especially those
who love to tinker with new
frameworks. If you have any
contents ^
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questions, issues, or requests,
please let me know at
lswest34+fcm@gmail.com. As
always, I’m also open to requests
for future articles.

FURTHER READING
https://www.meteor.com/ - Meteor
Homepage

EXTRA! EXTRA!
READ ALL ABOUT IT!

http://www.telescopeapp.org/ - A
social framework built in Meteor

Our glorious news reporters
are now posting regular news
updates to the main Full Circle
site.
Click the NEWS link, in the site
menu at the top of the page,
and you'll see the news
headlines.

Lucas has learned all he knows from

repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.

full circle magazine #97

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some
great guests on the show, telling
us first hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.

Alternatively, look on the right
side of any page on the site,
and you'll see the five latest
news posts.

The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.

Feel free to discuss the news
items. It's maybe something
that can spill back from the site
into the magazine. Enjoy!

The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

podcast.ubuntu-uk.org
13
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Ru n An d roi d Apps I n U bu n tu

Written by Ronnie Tucker

ver fancied having that handy
Android app in your Linux
distro? Or do you need an Android
app on your desktop for a
presentation, or for testing? Well,
Google’s ‘ARC Welder’ extension is
just what you need. Although, if
you’re using anything but Chrome,
you’re out of luck. This requires
Chrome.

ARC WELDER
First thing is to Install the ARC
Welder extension:
https://chrome.google.com/webst
ore/detail/arcwelder/emfinbmielocnlhgmfkkmkn
gdoccbadn (or search for it at:
https://chrome.google.com/webst
ore/category/extensions)

If you haven’t already got it, you
Click the ‘Add to Chrome’
can get Chrome from:
button
at the top right of the pophttps://www.google.com/chrome/
up window.
browser/desktop/

You’ll get a final confirmation
box before it installs. Add “ARC
Welder”? Absolutely!
The original blue ‘Add to
Chome’ button will change to say
‘Checking...’ for a few seconds.
After that’s gone, you’re done. You
now have an ARC Welder. One that
won’t burn your house down. Yay!

KDE USERS:

In KDE (Kubuntu 1 4.1 0 that I was
using), if I click ‘App Runtime for
Chrome’ shown in my K menu, it
pops up with a window of my
installed extensions. Instead I had
to use the Chrome ‘Show Apps’
button (top left in Chrome), rightclick the ARC Welder icon, choose
‘Create Shortcuts’, tick both boxes,
and click Create. This now puts an
ARC Welder icon in the Chrome
Apps folder on the K menu. You
need to do this only once.

So, let’s open ARC Welder. This
is either done using your desktop
menu, or using the icon in the
Chrome apps tab.

Click the yellow Choose button.
As the pop-up says, it needs a
directory to save stuff in. Give it a
directory, and we’re off to the
races.
full circle magazine #97
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HOWTO - RUN ANDROID APPS IN UBUNTU
I’ll use News Republic for this
tutorial. Copy the URL of the app.
Go to the site:
http://apps.evozi.com/apkdownloader/ and paste in the app
store URL.
Click the green download
button and save the APK file to
your hard drive.
With the APK downloaded, it’s
back
to ARC Welder. Click the ‘Add
Well, almost off to the races.
We need Google Android APK files. your APK’ button and choose the
downloaded APK file.
First, let’s choose an app to test
this with. Go to the store
ARC Welder will now give you
(https://play.google.com/store)
some options on how to display
and choose an app.

full circle magazine #97

the app. I’ll choose landscape,
tablet, and give it clipboard access.
Finally! Time to click LAUNCH
APP (in yellow at the bottom of
the ARC Welder window).

Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.

Yay! It worked!
Just remember that you need
to click and swipe as you would
with the touch-screen version.
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Written by Elmer Perry

n next month's article, I will
discuss the use of macros as
functions, but before I do, I must
discuss macro security. While
macros are a powerful tool when
used properly, macros can contain
code that is harmful to the data on
your computer. Through the years,
documents with macros have been
the transfer method for many
computer viruses. With a little
caution and a few settings, you can
minimize the chances of your
computer getting a virus from
document macros.

Li breO ffi ce Pt.49 - M a cro Secu ri ty
your files and settings. It's like
walking through a snake pit in your
bare feet: you will get bitten. The
only way this level would ever
make sense is on a computer that
is completely isolated from the
Internet and never opens a file that
was not created on that computer.
Not very likely.

Medium : This level is the “Are

you sure?” level. With medium
level protection, the document will
run macros if it comes from one of
the trusted sources, discussed
below, without any prompting. If
the document is not from a trusted
source, LibreOffice will prompt you
about whether to run the macros
in the document. You have the
choice: Yes or No. I have
recommendations later about how

High : This is the “hands off”

level. Only signed macros from a
trusted source, or macros from
trusted file locations, are allowed
to run. All others will have their
macros disabled. You have no
choice; you are never prompted.
This is a level where you don't
want the end users making the
decisions, but you want
LibreOffice to make the decision
for them.

Very High : This is the

SECURITY LEVELS

“paranoid” level. Only files from
trusted file locations can run
macros. Again, you are not
prompted or given a choice. If the
file doesn't come from a trusted
file location, the macros are
disabled. This is the most lockeddown, don't-trust-nobody level
there is. If you think the world is
out to steal your identity and know
all your secrets, you might be right,
and this is the level for you.

Open the macro security
settings through the menus: Tools
> Options > Security > Macro
Security (button). LibreOffice has
four different macro security
levels that cover security – from no
restrictions to highly restrictive.
Each level has its merits. Let's look
at each one in detail.

Low: This is the “Off” level. All
macros are executed without
prompting. They can run without
you knowing, and they can damage

to make this decision.

TRUSTED SOURCES
full circle magazine #97
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The Trusted Sources tab allows
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you to identify the trusted sources
for your documents.

reserved for office networks and
computers used by younger
students. Use these when you are
locking down a computer where
you want to limit the power of the
end user. I see this in my line of
work all the time. The company has
the user's computer limited in
what they can do to protect the
company's investment in the
computer and data. Sometimes,
this is set according to the
experience and necessity of the
users. If you are the network
administrator, you will need to
make this decision for each user.

Certificates: Certificates are

used to digitally sign documents.
Certificates come from a
certification authority. They are
usually used on web sites and
servers to authenticate the source.
The installation of certificates is
beyond the scope of this article,
but to digitally sign a macro, Tools
> Macros > Digital Signature.

File Locations: No matter what

level you use – except Low – I
recommend you define at least
one trusted file location. You need
at least one place where you can
run proven files with macros
without having to OK a prompt.
Don't use a location where you
usually download files from email
or the Internet. Use a location
where you collect and save
documents you need to keep.
Sometimes, two or three locations
are helpful. Also, make sure the
location isn't too general, like your
home folder.

RECOMMENDATIONS
Never, ever use Low. No, I mean
NEVER. Don't try to argue that you

know what you are doing, and you
have a firewall, anti-virus, and
malware protection. Don't do it!
No. No Low level setting. Go there
now in your copy of LibreOffice
and change it to something else.
There. Now, don't you feel safer
already? Now, we can calmly
discuss the benefits of the other
levels.

for yourself. I recommend this
setting for computers on your
home network. The setting gives
you protection, but does not take
away your right to make a choice. If
some computers are used by
students, you will want to educate
them on a good method for
making the decision for documents
from email and the Internet. Later I
will offer you a method that I feel
Medium is my preferred setting. is useful.
While it protects you, you also get
the choice of making that decision
High and Very High are best
full circle magazine #97
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As I said before, whatever level
you decide to use, I recommend at
least one trusted file location. In
fact, for the Very High setting, you
have no choice. Also, with file
locations, you can avoid the need
to sign the macros in every file
with a security certificate.

YOU ARE YOUR B EST TOOL
The most important virus
protection of all: the mushy gray
matter between your ears. If you
were not expecting a document to
contain macros, then, maybe, you
shouldn't allow the macros to run.
Follow your instincts that
contents ^
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developed in humans as a
protective measure. Be the
skeptic! If you have a feeling that
something is not right, maybe
something is not right.

level is good for most home
computers and networks. High and
Very High are good in office
environments where you need to
control the end users interaction.
Always take precautions when
Take these steps when
dealing with documents coming
receiving a new file. Open the file from other people. Sometimes,
from an untrusted file location, but people unknowingly pass on
do not allow the macros to run.
documents that contain malicious
Examine the macros in the
code.
document. If you have any
questions about the macros, asks
the person who sent the
document. If they cannot give you
a satisfactory answer as to why the
macros are there, eliminate the
document. Chances are, they are
not your friend and do not have
your best interest in mind (or their
computer is infected with a virus).
Yes, this may all sound a little
paranoid, but better safe than
losing time and data. If the
document is clean (no macros) or
the sender gives you a satisfactory
reason for the macros, move the
document to a safe file location.
While macros are useful, people
also use them for malicious
purposes. LibreOffice provides you
with four different levels of
protection against malicious
macros. You should never use the
Low level setting, but the Medium

FCM#1 00
SURVEY
The question is:

What are your most
loved/hated flavors and
releases?
Take the quick survey and we'll
publish the results in
FCM#1 00.

http://goo.gl/DPt2q0

Elmer Perry's history of working,

and programming, computers
involves an Apple ][E, adding some
Amiga, a generous helping of DOS
and Windows, a dash of Unix, and
blend well with Linux and Ubuntu.
He blogs at
http://eeperry.wordpress.com
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Written by John Eddie Kerr

n the letters section of Full Circle
#96, fellow reader Tiago wrote
in to say that TexStudio is an
excellent LaTeX text editor. I
agree; I also use TexStudio and it
will be the LaTeX editor of choice
for this month's installment.
Gummi and LaTeXzila should not
be left out either, and the choice
of software may come down to
what is the best tool for the job, or
for you. Gummi may be the best
writing tool for an essay or a quick
document that will not require
special formatting.
Thank you Tiago for your letter.
The LaTeXzila project is looking
for funding to create a real time
file viewer and other
improvements, see
https://wiki.gnome.org/Apps/LaTe
Xila/donate for more information.
An item to add to your
documentation library is a LaTeX
cheat sheet. Cheat sheets have
many of the commands that you
would use. There are standard
cheat sheets:

U se La TeX - Pa rt 3

you will get help from the menus in
FIND A TEMPLATE
TexStudio sooner or later. Not
everything is there; for instance
There is no point in reinventing
drawing a double line is a topic
the wheel, many word processing
that you will have to search in
packages provide templates, and
Google in order to do it.
the LaTeX community has provided
The Quick Start dialog is found many as well. A Google search on
“Latex business cards” pointed to a
under the Wizards dialog for
number of templates. I
creating the preamble of your
document. The menus in TexStudio downloaded three of them and
A cheat sheet is handy to have
found that there are many
are extensive and help our
with a basic text editor or an app
different approaches to creating
workflow when our memory fails
like Gummi. However, one of the
business cards. What is common is
us.
features of TexStudio (and why
that they all have a section that
Tiago and I like it so much) is that
TexStudio has a built-in cheat sheet M AKE YOUR O WN B USINESS places the data fields in your card,
and a section where you may enter
that can automatically fill in the
C
ARDS
the information for your card.
commands as you type them, or,
with a click of the mouse, show you
I often say that “mountains I can
A plain business card template
a drop-down menu of commands
move today, little molehills can
that I found has this personal data
and command categories.
take forever”. I just never get
section:
around to making business cards
The menu can be incredibly
%%%%%%%%%% DEFINE USER
for myself, and the fact that I
useful, as they organize the
MACROS BELOW
would not hand out 500 cards in a SPECIFIC
%%%%%%%%%%%
commands by category and in a
{}
hundred years has not helped the \def\Who
natural language. If you know the
\def\What
{}
command, you can still start typing project at all. At a conference I
\def\Where
{}
attended last week, I discovered
\def\Address {}
it, and TexStudio will fill in as you
\def\CityZip {}
that I needed business cards, and
type. How many commands you
{}
since my hotel had a public access \def\Email
memorize will depend on how
\def\TEL
{}
printer, I decided to make some on \def\FAX
{}
often you create documents in
\urldef{\WEB}\url{}
my laptop using LaTeX.
LaTeX, but LaTeX is so powerful,
full circle magazine #97
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http://www.stdout.org/~winston/l
atex/latexsheet.pdf as well as
specialised ones like this for math
symbols:
http://estudijas.lu.lv/pluginfile.php
/1 4809/mod_page/content/1 2/inst
rukcijas/matematika_moodle/LaTe
X_Symbols.pdf. A Google search
will undoubtedly uncover more.

HOWTO - USE LATEX

Within the brackets above you
will insert your data, save and then
compile; the file places the data on
the card.
However, using three different
editors, and different files, I
discovered that, with business
cards, another common “feature”
is that, after you save and compile,
the cards do not appear in the
editor's PDF viewer. To see the
results of your work you will have
to open the PDF file with your
computer's PDF viewer.

feature that would attract many
universities to using the service. It
would also be hard for students to
lose homework!! Another
advantage to any school is with
everyone using the same tools online, the ability to support LaTeX is
easier and they can do it on all
computer platforms because the
service is web based. However, if
everyone created documents using
TexStudio it would be easier to
support LaTeX as well.

Try different files, and modify
them to make your own unique
card.

Take a look at ShareLaTeX if not
to just view the templates; you do
not have to avail of their service to
use the templates as you can
download them to your computer.

SHARELATEX

Until next time, enjoy exploring
LaTeX.

While searching for templates
you may find yourself landing on a
site called ShareLaTeX. This site is
worth investigating as it provides
you with an environment to create
LaTeX documents online (or in the
cloud). You will be able to store
your documents on their servers
and edit them from anywhere
using their on-line editor. Single
user accounts are free, if you want
to collaborate with others there is
a charge. It is the collaboration

P YTHON SPECIAL EDITIONS:

http://fullcirclemagazine.org/issue-py01 / http://fullcirclemagazine.org/issue-py02/

http://fullcirclemagazine.org/pythonspecial-edition-issue-three/

http://fullcirclemagazine.org/pythonspecial-edition-volume-four/

http://fullcirclemagazine.org/pythonspecial-edition-volume-five/

http://fullcirclemagazine.org/pythonspecial-edition-volume-six/

John Eddie Kerr is a Law Librarian at
a county law library in Guelph,
Ontario, Canada. Ubuntu powers his
desktop at work and at home. He is a
member of the Kitchener-Waterloo
Linux Users Group and the WFTLLUG.
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Prog ra m m i n g J a va Scri pt - Pa rt 2

Written by Gergo Bogdan

n the first part, I talked about
how JavaScript has evolved over
the years, what is the current
status of the language, and why it
is so widely adopted by
developers. In this part, I will focus
on JavaScript Objects and
functions. Since I received an email
from Ray (one of our readers,
thank you for contacting me) with
some questions, I will address
these at the end of the article in
the Questions and Solutions
section.

J AVASCRIPT O BJECTS
In JavaScript, everything is an
object, even functions are objects,
which, if you are familiar with
other programming languages,
may seem a little odd. But, don’t
worry, this gives JavaScript some
real power.
JavaScript is a dynamic
programming language, which
means objects can have different
values assigned during runtime,
without any problem. For example:

myName = 123;

In the first case, the myName
stores a string value; in the second
case it should store an integer, 1 23,
but JavaScript has a special type,
Number
(https://developer.mozilla.org/enUS/docs/Web/JavaScript/Referenc
e/Global_Objects/Number) to hold
numerical values.
Since JavaScript is a dynamic
language, I can extend objects in
any way I want. For example, if I
create a new object:
var myHouse = { nrOfRooms:3,
size:100 };

It creates an object:
Object {nrOfRooms: 3, size:
100}

Let’s extend this with a couple
of properties:

FUNCTIONS
Let’s look at the code below:

myHouse.getInformation = function() {
console.log("The house is " + this.size + " mm2 big
and it has " + this.nrOfRooms + ".");
}

If you invoke this function as:

myHouse.getInformation();

it will display : The house is 1 00 mm2 big and it has 3.
Functions can have parameters:

myHouse.isBiggerThan = function(otherHouse) {
return this.size > otherHouse.size;
}

We can invoke the function:

myHouse.isBiggerThan({size:98});

or

myHouse.isBiggerThan({size:198});

In the first case, it returns true and in the second case false. Notice, I
passed in only a simple object with one property, size, so the code can
execute correctly, but I could have written this too:
myHouse.isBiggerThan({size:198, nrOfRooms:5, price:8500,
currency:"EUR"})

or

myHouse.price = 1500;
myHouse["currency"] = "USD";

var friendsHouse = {size:198, nrOfRooms:5, price:8500,
currency:"EUR"};
myHouse.isBiggerThan(friendsHouse);

These result is the following
object:

The result will be the same.

var myName = “Greg”;

full circle magazine #97
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a function called plantTrees, and
receives a parameter nrOfTrees,
and it sums up the number of trees
As you can see, there are three in the forest. Or it may store the
different types of animals which
ways to create custom objects:
live in the forest; the topic does
• The first, also called JSON
not really matter, the idea is to get
(JavaScript Object Notation),
you familiarized with object
defines objects using the curly
braces and specifies the properties notation and function creation, we
will use this a lot.
and their values separated by a
colon.
• The second option is to use the . Q UESTIONS AND S OLUTIONS
(dot) operator, and write the name
of the new property and assign a
Question: Ray asked how we
value to it.
can select some information from
• The third option is to use the
a file, especially a SQLite database
index [] operator, which receives a using JavaScript.
string as a parameter and a value
to assign. If you know other
SOLUTION :
programming languages, you can
There are two approaches, two
imagine JavaScript objects as a
scenarios. The first one is when
kind of special dictionaries or
you have the SQLite database
maps.
available on the client machine,
where the browser is running. In
Functions may or may not have this case you can use the SQL.js
return values. In the case of the
(https://github.com/kripken/sql.js/)
isBiggerThan() function, I have not library to load the SQLite files.
specified a return type, nor that it Even more, you can do queries and
will have a return value, but I could create data schemas using
easily return a boolean value (true JavaScript. The page on GitHub has
or false), JavaScript permits this.
good code examples; you can start
using those for loading your
As an exercise, you can create
database and querying data.
other objects which simulate real
life objects, like a forest which has
The second scenario is when the
full circle magazine #97
Object {nrOfRooms: 3, size:
100, price: 1500, currency:
"USD"}

var fs = require("fs");
var file = "rays_data.db";
var sqlite3 = require("sqlite3").verbose();
//
// create the db instance
//
var db = new sqlite3.Database(file);
db.serialize(function() {
//
// create the table if the database file was missing.
//
if(!fs.existsSync(file)) {
db.run("CREATE TABLE People (firstName
varchar(50), lastName varchar(50))");
}
//
// create a parameterized, prepared statement
//
var stmt = db.prepare("INSERT INTO People VALUES
(?,?)");
//
// run the statement twice
// each ? in the statement is substituted with the
parameter
//
stmt.run("John", "Doe");
stmt.run("Jane", "Doe");
// close the statement
stmt.finalize();
//
// query the database and log the result to the
console
//
db.each("SELECT rowid AS id, firstName, lastName FROM
People", function(err, row) {
console.log(row.id + ": " + row.firstName + " "
+ row.lastName);
});
});
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SQLite database is available only
on the web server and the client is
accessing the web server through
the Internet. In this case, you need
to have a server-side component
(this can be node.js based) which
reads the SQLite database, and,
using HTTP requests, sends the
data back to the client’s browser.
In this case, the client side
JavaScript is more complex,
because it needs to use AJAX calls
to load the data. Here is a sample
node.js code which connects to a
SQLite database, creates a new
table if it does not exist, and
inserts two new entries in the
table. After the insert it queries
the table and writes the data to
the console.
To execute the code on the
previous page, you will need to
have node.js (https://nodejs.org/)
and npm installed, and install
sqlite3 through npm using this
command:
npm install sqlite3 –save

When all is set up, you can run
the program using:
node sqlite_reader.js

C:\Users\Gergo\Documents\nodesqlite>node sqlite_reader.js
1: John Doe
2: Jane Doe
C:\Users\Gergo\Documents\nodesqlite>dir
Directory of C:\Users\Gergo\Documents\nodesqlite
08/05/2015 21:09
<DIR>
node_modules
08/05/2015 21:36
2,048 rays_data.db
08/05/2015 21:23
953 sqlite_reader.js
2 File(s)
3,001 bytes

sqlite_reader.js.
The output should look
something like that shown above in
the command line (I was executing
under Windows, but the output is
the same under Linux too, since
node.js runs the same way in both
environments).
In future articles, I will present
how to create a new HTTP server
using node, and how to transfer
data from the server side to the
client side – everything using
JavaScript.
I would be happy to hear from
you; what are the topics in
JavaScript which you would be
interested in. Please feel free and
email me your topic ideas, the
same way as Ray did. Thanks again,
Ray!

Supposing you named your file
full circle magazine #97

Gergo Bogdan is a software

engineer, blogger, tech enthusiast
from Budapest who is riding the
waves of the constantly changing IT
ocean. You can check his website at:
http://grelution.com.
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I n k s ca p e - P a r t 3 6

Written by Mark Crutch

ver the past few instalments,
I've detailed the workings of
the Tiled Clones dialog. As well as
producing some interesting, and
often kaleidoscopic, visual effects,
this dialog can be useful for
creating particular arrangements
of objects. Because the dialog's
units are based on the bounding
box of the parent object (rather
than using explicitly stated
dimensions), this approach isn't
terribly useful for positioning
objects at specific coordinates or
locations, so the next few articles
will look at the different tools
Inkscape provides for these kinds
of manipulations.

such as the new Measure tool in
0.91 – but it's still a long way from
a fully fledged CAD application.
With that limitation in mind, we'll
start with the most obvious form
of positioning: snapping to a grid.
Inkscape is rather flexible when
it comes to grids. You can have
more than one active at a time,
and each one can be either
rectangular (based on horizontal
and vertical lines), or axonometric
(vertical lines, plus two sets of
angled lines). Usually, however, it's

It's important to remember,
however, that Inkscape is not a
“computer aided design” (CAD)
program, of the sort used by
architects or engineers. If you want
to create technical drawings that
could be used by builders or
manufacturing companies, there
are other Open Source programs
that might serve you better, such
as FreeCAD, OpenSCAD, or QCAD.
With each release, Inkscape gains
more functionality in this area –
full circle magazine #97

easiest to work with just one grid
at a time, most commonly a
rectangular one. Launch Inkscape
to create a new document, and, if
there's no grid visible, try pressing
“#” or use View > Grid to enable
the display of the default grid. To
edit this grid, or to add a new one,
use the File > Document
Properties menu, then select the
Grids tab.
To create a new grid, select
either Rectangular or Axonometric
from the pop-up menu at the top,
then click the New button. Each
grid gets its own tab in the
“Defined grids” section, with
slightly different icons for the two
grid types – but the icons are
always blue, regardless of the
color of your grid lines. They're
named automatically, with no easy
mechanism to change the name,
and no distinction in naming
between the two grid types. The
use of similar, identically-colored
icons and fixed, generic names
means that managing numerous
grids is less than straightforward,
so it's best to stick with just one or
two. The tab bar isn't scrollable –
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the dialog just grows in size if you
start to add too many; and there's
also a practical limit imposed by
the UI.
Each grid has three checkboxes
that control snapping and visibility.
These are in addition to the View >
Grid option (toggled via the “#”
key), so, for a grid to be visible, you
need both of the top two
checkboxes to be enabled and the
View > Grid toggle to be on. Think
of the toggle as a global way of
showing and hiding all the possible
grids at once, with the checkboxes
being a way to more finely control
what each individual grid
contributes.
The first checkbox, “Enabled”,
simply switches the entire grid on
and off. With it unchecked, the
remaining options are all disabled
and the grid plays no part in
snapping or display. You might use
this if you have multiple grids so
that only one is switched on at a
time – typically when swapping
between rectangular and
axonometric within the same
drawing.
contents ^
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The second checkbox, “Visible”,
has only a visual effect. With this
unchecked, the grid will not be
displayed, but can still play a part
in snapping if the grid is enabled
via the first checkbox. As it can be
difficult and frustrating to snap to
a grid you can't see, I strongly
recommend always leaving this
option checked.

snapping to invisible grid lines.

The remaining options in the
dialog are used to define the
displayed lines, and are fairly selfdescriptive. You can position the
origin of the grid – 0,0 is good for
most drawings – and define the
spacing between grid lines in both
the x and y directions. As most
people usually need a square grid
it would be good to have an option
The third checkbox, “Snap to
to link these values, but it's no
visible grid lines only”, is slightly
great hardship to simply enter the
misleading with its labelling –
same value into each field. You can
though the tooltip is clearer. This
set the color, and opacity for the
checkbox concerns grid lines that
grid lines – it's usually best to keep
are automatically suppressed as
you zoom out. If you were to zoom the opacity low so that they are
less dominant on the screen, and
out far enough, the grid lines
would become so dense that they less likely to be mistaken for real
lines in your drawing. By setting
just appear as a solid colored
different colors or opacities for
background. Inkscape avoids this
major and minor grid lines, you can
by hiding grid lines that would be
drawn too densely, and would have create a “graph paper” effect. This
becomes visible only when you're
been a hindrance rather than a
zoomed in closely enough, and, if
help. With this option unchecked,
you do decide to use this feature,
you can still snap to these
suppressed lines, but I recommend it's best to make the major lines
leaving it enabled so that you snap more opaque than the minor ones.
Set the “Major grid line every” field
to only visible grid lines. This may
to 0 if you want to disable this
require you to zoom in a little to
feature. Finally, the “Show dots
get the precise snapping point
you're looking for, but it's usually a instead of lines” checkbox does
exactly what it describes, and
good trade-off against the
results in a more lightweight view
frustration of constantly misof the grid. Setting this option, or
full circle magazine #97

changing the line colors, can make
it easier to work with multiple
grids that are all active at the same
time, should you need to.
The options for creating an
axonometric grid are broadly
similar to those for creating a
rectangular one. There's only a
single entry for spacing, and a
couple of new fields for defining
the angles of the x and z axes. The
default values of 30° are fine for
isometric drawings, though you
might want to use 45° for an
“oblique” projection. Setting either
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of these too close to 0° or 90°
results in rendering problems. Any
value outside this range is capped,
though that isn't reflected in the
displayed number. Unfortunately,
there's no “Show dots instead of
lines” option for axonometric
grids.
Also missing is the ability to
create logarithmic or polar grids.
Both are possible via extensions –
though these create “real” SVG
objects, rather than Inkscape grids,
so they can't be toggled with the
“#” key, and have to be snapped to
via object snapping, not grid
snapping. If you do have need of
these grid types, however, you can
find them under Extensions >
Render. In 0.48, you're looking for
the Cartesian Grid and Polar Grid
entries, whereas in 0.91 they've
both been moved into an extra
“Grids” submenu. The image on the
next page (top right) gives an
example of grids produced using
these extensions.
Going back to Inkscape's
rectangular and axonometric grids,
the setup we've done so far just
lets you visually align objects. To
really use them as layout tools,
you'll also need to enable
snapping. As with grids, there's a
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global toggle for snapping: press
the “%” key (Shift-5 on my
keyboard) to trigger it, use the
View > Snap menu entry, or click
on the first icon on the Snap
Controls Bar (button 1 in the
screenshot below).
With snapping enabled, you
also need to have either button 2
or 3 (or both) enabled. These
dictate what parts of your drawing
can be snapped: button 2 enables
the snapping of bounding box
corners, and kicks in when you
resize or move an object using the
Select tool; button 3 enables the
snapping of nodes and handles, so
has an effect when you initially
draw an object, or subsequently
edit it using the appropriate
object-specific tool. Enabling
either button makes a few others
available that you can use to
enable more specific snappings –
such as snapping the center point
of a bounding box, rather than just
its corners – but most of the time I
find that one of the main two
buttons is good enough.

As well as defining which parts
of an object should snap, we also
have to tell Inkscape what we want
them to snap to. Button 4 enables
snapping to the grid. The button
after it enables snapping to
guidelines (covered in Part 1 6 of
this series) – I usually leave this
enabled as it has no effect unless
you specifically add some
guidelines, in which case you
probably want it switched on
anyway. The other button in this
section enables snapping to the
There's one final setting to look
page border, which I find to be less
at (shown left) regarding snapping,
useful for my own projects.
so it's back to File > Document
Properties, but this time select the
Snap tab.
Within this panel, you can set
how voracious Inkscape is in its
efforts to snap. For each section,
the “Always snap” option means
exactly that: snap to the nearest
snapping point, regardless of how
far away it might be. This is useful
if you absolutely have to draw to
the grid to ensure dimensional
accuracy. More generally, however,

full circle magazine #97

27

“Snap only when closer than”
offers a good trade-off between
accuracy and freedom. With this
mode enabled, you can freely place
your objects, nodes and handles,
unless they get close to a snapping
point, in which case they will jump
to that location. Exactly how close
is set by the “Snap distance” slider.
The values are measured in screen
pixels, so zooming has an effect on
the effective “hit area” in which
snapping occurs: zoom in to give
yourself more freedom, or zoom
out to make snapping more likely.
Within File > Inkscape
Preferences (Edit > Preferences in
0.91 ), there are “Grids” and
“Snapping” panels that offer a few
other options. The defaults are
usually fine for most users, but if
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you find yourself heavily using
grids or snapping, it might be
worth taking a look to see if any of
these settings can improve your
workflow.
With a grid visible and snapping
enabled, you should find it quite
easy to create shapes that stick to
the grid intersections. When you
need to place nodes off the grid,
you can either press the “%” to
disable snapping (whilst leaving
the grid visible), or more easily (on
a US or UK keyboard, at least) you
can press “#” to turn the grid off
entirely, removing it as a snap
target. Often, however, there's a
requirement to place objects
relative to one another, rather
than to an absolute grid; that will
be the subject of the next
instalment...

Mark uses Inkscape to create three
webcomics, 'The Greys', 'Monsters,
Inked' and 'Elvie', which can all be
found at
http://www.peppertop.com/

N EW SPECI AL EDI TI ON S PAGE

It's not perfect, by any stretch of the imagination, but this new page on the site links to the most
popular Special Edition topics. As of writing there are links to GIMP, Inkscape, LibreOffice,
Python and Scribus Special Editions.
http://fullcirclemagazine.org/special-editions/
full circle magazine #97
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Written by Dr. Laurent ALDON

he aim of this mounting is to
simulate the light curve
observed by astronomers over
time. In astronomy, a light curve is
a graph of light intensity of a
celestial object or region, as a
function of time. In the case of
asteroids, the study of the light
curve, together with other
observations, can allow us to
reconstruct the shape of the
object. This project was developed
for E. Barres School (Le Cres City)
in the framework of the French
Science Fair.

SETUP OF THE DEVICE
A rough piece of basalt rock
was drilled and mounted on the
axe of a stepper motor. The
surface reflects some light
depending on the angular position.
Readings on analog input A0 were
read using the serial port, to log
the steps the motor has taken. A
1 6x2 LCD display (I2C protocol)
was used to show both angle and
light measurements.
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Asteroi d Li g h t Cu rve Si m u la tor
RESULTS

ARDUINO CODE

Young children at school were
very impressed to see the piece of
basalt starting to rotate. After
recording some data, we have
plotted the measurements as
shown below right.

http://pastebin.com/rJfVtWny
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Ch rom e Cu lt

Written by S. J. Webb

efore my Chromebook, I had
minor experience with the
Chrome OS. I never lived in the
cloud. Cloud computing is simply
defined as using a network of
remote servers to store, manage,
and process data on the internet.
Attempting to explain this concept
is hard to non-users who use
Window PCs; however Ubuntu
users understand the cloud
concept due to the former Ubuntu
One file services.
The best analogy to explain
cloud computing is our traditional
banking system. We take our
money and deposit it into a
checking account with the bank.

hard drive. Yet we are trending
towards the cloud in everyday life.
I then started to look at my other
devices that I own: a Kindle Fire
and an iPod. I use both devices on a
So we take our files, the money, daily basis. I use a Roku which
streams my movies and shows. My
and deposit it into our Google
Drive. The Google Drive is the bank iPod contains the tunes of Nirvana
with our checking account. I access and Foo Fighters which are stored
on the Apple cloud. I then realized
the file in my account as needed,
my entertainment sources utilize
the file is the debit card. Clearly
the Google Drive and my checking the cloud in some form.
Consequently, I am a cloud user by
account work on the same
principle. The data is there when I default. I already have a web based
hard drive with movies and books.
need it.
We use our debit cards to make
payments as needed. Let’s apply
these actions to using our Google
Drive.

Despite knowing this analogy, I
was not a fan of the cloud. I
disliked not having a traditional

full circle magazine #97

This realization led me to my
Chromebook. I am a first time user
in the Chrome OS ecosphere. I will
be drifting away from Ubuntu
MATE into the Chrome OS. There
will be challenges using a heavily
modified Linux kernel by Google.
Like Ubuntu, the Chrome OS tends
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to get frequent upgrades too.
These updates typically are subtle,
such as a change in an icon or
different font. Below is the login
for using the Chromebook.
The storage hard drive for my
files is the Google Drive. The
Google Drive operates within the
Chrome Browser. Each Gmail
Account has an attached Google
Drive. The Google Drive is limited
to 1 5 GB for storage. On purchase
of a new Chromebook, you can
redeem an offer to get 1 00GB of
Google Drive storage free for 2
years. Always empty your trash
folder in the Google Drive; the files
in the trash folder also count
against your 1 5GB for storage.
Below is a snapshot to my
Google Drive. You can set it up like
any ordinary drive with folders, etc.
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One bonus to Google Drive is the
ability to share a folder from one
Google Account to another Google
Account. This is a great feature for
photo sharing or group editing a
document.

The Google Drive can be used
to sync across devices and home
computers. Unfortunately, the
Linux OS is not officially supported
for the device syncing at this time.
I have synced a Win 7 computer to
my Chromebook successfully. I
have yet to try my wife’s MacBook
Pro. If you are having trouble with
the Google Drive, use this link:
https://support.google.com/drive/
?hl=en#
There are other companies that
offer cloud storage besides

Google; Amazon is one that comes
to mind. I incorporated a 32 GB SD
card into my Chromebook so I can
increase my offline storage. Now
let’s take a look at the
Chromebook desktop after the
login screen.

just to the right are lying on the
Shelf. The right corner has a coffee
cup icon, Wi-Fi, and time denotes
the Profile section of the Chrome
OS. You also receive system
notifications in this area too.

The desktop can be divided into
3 areas: Launcher, Shelf and
Profile. The Launcher connects you
to the Chrome Web Store, Google
Docs, etc. The Shelf is a dock where
you can pin programs for quick
access. The Shelf can be placed in
the bottom, left, or right side of
the screen using a right-click on the
mouse. The Profile is the settings
and administrative section to
Chrome OS. In the picture below,
the magnifying glass in the left
corner is the Launcher. The icons
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In the Profile (previous page,
top right), you can change settings,
run updates, and other items. You
use this to monitor battery life,
available Wi-Fi networks, and to
log out. Under the settings menu, I
disabled the function for multiple
Gmail Accounts on my
Chromebook. I did this to increase
my device security. You can enable
Bluetooth and other peripheral
devices. Using the Settings, I
changed my background from
being windmills to a Boston Harbor
Picture from 201 4.

up window. This feature reminds
me a bit of the Unity Desktop. You
can search your Chromebook for
files or applications using the
search bar. The Shelf has Google
Drive, Chrome Browser, Gmail,
Google Docs, Google Slides, and
Google Sheets as native icons. You
can add any app to the Shelf.

The Web Store can be
considered the “Chrome OS
Repos.” In this area you will find
games, social media, and other
apps to incorporate into your
Chromebook. Some Chromebook
When you click on the Launcher, Users have 1 00 plus apps on their
the Chromebook generates a pop- profile.

I added the File App to my Shelf.
This is the Blue Circle with a White
Folder Icon just to the left of the
Chrome Browser. I recommend
pinning the File App to the Shelf.
This allows for easy access to the
SSD, SD Card, and Google Drive.
This allows you to see where you
are saving your files. You can save
your files offline, SD Card, or to the
Google Drive – depending on Wi-Fi
connectivity. The File App allows
for simple review of where your
data is at all times.
You cannot tweak the features
to the Chrome OS. There is no KDE,
Unity, or other DEs. There are
extensions for the Chrome
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Browser that are inspired from
KDE and Unity. Nevertheless there
is not much tweaking for the user
interface. Since I like hot rods, I
placed a pin-up extension into my
Google Homepage.
Next month, I will explore the
pros and cons of using the Google
Docs.

SJ Webb is a Linux Hobbyist and

Research Coordinator. He enjoys
fishing, hot rodding, and spending
time with his kids and wife. He
thanks Mike Ferarri for his
mentorship.
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Wri te For Fu ll Ci rcle M a g a zi n e

Written by Ronnie Tucker

G UIDELINES

T

he single rule for an article is
that it must somehow be

document.

REVIEWS

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

G AMES/APPLICATIONS

linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc). • Do not use tables or any type of
bold or italic formatting.

RULES

• There is no word limit for articles,
but be advised that long articles
may be split across several issues.
• For advice, please refer to the

Official Full Circle Style Guide :

http://url.fullcirclemagazine.org/7
5d471
• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND

GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

If you are writing a review,
please follow these guidelines :
When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS
If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you
access to the raw text to translate
from. With a completed PDF, you
will be able to upload your file to
the main Full Circle site.
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When reviewing games/applications please state clearly:
•
•
•
•
•
•
•

title of the game
who makes the game
is it free, or a paid download?
where to get it from (give download/homepage URL)
is it Linux native, or did you use Wine?
your marks out of five
a summary with positive and negative points

H ARDWARE

When reviewing hardware please state clearly:
•
•
•
•
•
•
•

make and model of the hardware
what category would you put this hardware into?
any glitches that you may have had while using the hardware?
easy to get the hardware working in Linux?
did you have to use Windows drivers?
marks out of five
a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
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Get 25% off any SpiderOak package
with the code: FullcirclemagFans
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Written by Ronnie Tucker

y father recently bought
chickens and I thought it
would be nice to have an Internet
camera out there to keep an eye
on them. Nice idea, but how can it
be done when these Wi-Fi enabled
cameras are out of Wi-Fi range? I
can’t run a giant network cable
through the garden.
The answer is powerline
adapters. I was highly sceptical of
them at first, but I have to admit
that they do work, and surprisingly
well.

DISCLAIMER: I’ll have to be a

I P Ca m era Wi th Powerli n e Ad a pter

wired to your internet router. Your
second plug goes wherever you
need a network point. In a chicken
coop, in my case.

wouldn’t run in Wine.

You can add more plugs to your
The good thing about these
powerline network, but try to keep
them all the same type. Otherwise, cameras is that they pan and tilt. In
other words: you can move them
TIP : when pairing the plugs
you’re asking for incompatibility
by remote control. Most come with
together, do it in the same room as and nightmares.
infrared LEDs on the front which
it will save you a lot of legwork.
will allow night vision, too. The
IP CAMERAS
back of the camera has an
ethernet port, Wi-Fi antenna,
IP (Internet Protocol) cameras
power socket, and usually several
come in many shapes, sizes and
connections for sound and alarms
prices. There are two major
(if required). All we really need
manufacturers: Wansview and
here are the power and ethernet
Foscam.
ports.

bit vague in this article as there are
many different types of powerline
adapters and they all work
differently. Same with IP cameras
and routers.

POWERLINE
The idea behind the powerline
adapter is this: you buy a pair of
power outlet plugs which have
network sockets on them and
several flashing indicator lights.
You plug your first one into the
wall and have its network socket

don’t want an expensive camera in
a chicken coop.

Most come with encryption
built in that you can enable. This is
handy if your power source is
shared with other residents. This is
not something I’ve tested, but to
enable it I think it requires the
manufacturer’s software, which I
found was Windows only and
full circle magazine #97

Yes, they’re cheap makes with
only 640-pixel wide images, but I
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So, you’ve got your powerline
adapter plugged in where you
want it. Plug your network cable
from the powerline to the camera,
then power on the camera. This is
important as I find that powering
on the camera first, then plugging
in the network cable, doesn’t
always work for getting an IP
address. Give the camera at least
one or two minutes before writing
it off, as mine takes at least a
minute to boot up and go through
its up/down, left/right test
sequence.
contents ^
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IP ADDRESS
Most IP cameras come with a
sticker on the underside of it. This
gives you the default admin
password (for initial setup), a
dynamic DNS url, and (sometimes)
a default IP address. My one didn’t
come with an IP address on the
sticker, so I’ve no idea what it’s IP
address is so I’ll need to find it. You
can, sometimes, get it using the
dynamic DNS URL, but they’re
quite often in China, incredibly
slow, and not exactly trustworthy.
So, I’d recommend not using it and
setting up a faster dynamic URL,
but we’ll come to that later.
Again, I have to be a bit vague

here as all routers are different.
I’m using a BT HomeHub 4 (in the
UK) so your router will no doubt be
different. But, either way, you log
in to your router and head to the
DHCP table page (if there is one)
or to a visual list of attached
devices. In there you’ll see the
device and its IP address.
In my case, it was a device I
didn’t recognise, and I knew that
my main powerline was in LAN2
(on my router), so I knew right
away that was the camera. It won’t
always have an easily recognisable
name!
To test things I entered the IP
address (1 92.1 68.0.2 in this case)
into my browser. This should let
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you log into the camera with the
default details which you can, of
course, change.
Success!
So, I can access the IP camera
over the network. First thing I did,
which isn’t a necessity, is to head
back into my router and tell the
router that I want that device to
have the same IP address every
time. With that saved I know that
my camera will always be
1 92.1 68.0.2.
By default the IP cameras use
port 80 which is the default
internet port – that needs to be
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changed. In the camera settings
will be a place to edit the IP
address and/or port number. I’ve
changed mine to port 82.
I also changed the password for
the admin account, and added a
guest operator account. This
means I can give people the guest
login to let them view, but not
edit, the camera.
If you plan on having more than
one camera online, then each one
needs to use a different port
number.
So, now that the port is
changed, you need to tag that
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onto the URL. My login now is
http://1 92.1 68.0.2:82. The colon 82
forces it to use port 82.

what to do when we enter that
URL.

If you’re like me, then your IP
address will change each time to
reconnect to the internet. Most
routers have a setting for dynamic
DNS which will let your router ping
its new IP address to a provider
who will associate that IP address
with an easy-to-remember URL.

Somewhere in your router will
be a page for port forwarding. It
what’s compatible with my router. URL to log into my camera.
may come under firewall. What
You’ll need to log into your router
we’re going to do is first create a
and go to the dynamic DNS page to
But wait. Typing in the dynamic label, or name, for each camera. So
see what it will/won’t accept.
DNS URL doesn’t load the camera! I add a new application (as my
router calls it). For protocol I keep
Whichever service you want to PORT FORWARDING
it at ‘any,’ and I enter 82 for port
use, create an account with them
range, 82 for translate to, and save
and sign in. Under hostnames
When you enter your dynamic
it. Now I choose my application
you’ll choose a name and one of
DNS URL, you’d expect to log into again (ie: the camera) which is
their URLs. I chose, funnily enough, your camera. But no. Why? Because associated with port 82 and link it
chickens, then one of their URLs.
the URL is using port 80 by default. to the device (the camera).
We need to add a colon and your
Head back again to the router
camera’s port number (eg: :82), but
Yes, it’s a bit confusing at first,
page for dynamic DNS and give it
first we need to tell the router
but the router needs to know
your username and password for
your hostname.

There are many different free
dynamic DNS providers out there,
but I use DTDNS.com as this is

Now, when I reconnect to the
internet my router will give DTDNS
my new IP address and I can use my

Thus far we can log in to the
camera on the network, but what
about from outside of the
network? We need a dynamic DNS
for that.

DYNAMIC DNS
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where to send things. When our
DNS URL comes in, the router has
no idea where to send that port 82
data. We’re telling it here to send
that port 82 data to the camera.
Now, when I enter my DTDNS
URL with the :82 at the end I go
straight to my camera.

I was a powerline sceptic, but
now I’m a believer!

Footnote from Mike Kennedy
(FCM proofreader) : I’ve used

MOBILE APPS
There are many different apps
you can use for viewing IP cameras,
but for Android I use tinyCAM
Monitor (which is free).
model, DNS URL, port number, and
my guest login.
I add a new camera and give it
the relevant settings such as make,
Not in the screenshot shown
here, but at the top of that screen
is a check to see if the camera is
detected, found, and online. If it
says it’s all OK, then you’re good to
go. Go back and choose your
camera from the list, sit back, and
watch the show.
They may be only chickens, but
they’re far more interesting than
most of the current TV shows.

CONCLUSION
Obviously, you can take this
further with several cameras
throughout your house or
full circle magazine #97

property. You can, if you wish, add
microphones to your cameras and
listen to what your camera is
hearing. Some cameras even allow
speakers to be added to let you
use it as an intercom device of
sorts. Even alarms can be wired
into some cameras.
The main star of the show is the
powerline adapters. Without them
there’d be no camera in the
chicken coop. A testament to their
power is that the coop is quite a
distance from the house (ie: long
power cable) and the powerline
adapter itself is plugged into a
four-way extension cable. This is
normally a no-no, but it’s a
necessary evil as there’s only one
socket in the coop area.
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powerline adapters at various
customer sites - usually very
successfully. However, sometimes
they didn’t work, or worked poorly.
On investigation, the cause was
usually a faulty PSU (power supply)
in some other device, typically in a
very cheap desktop PC,
photocopier, printer, etc. So, if the
powerline devices are problematic,
try switching off most/all other
devices, until the troublesome
one(s) are identified. Then,
perhaps the PSU is actually faulty
(though, seemingly still “working”),
or perhaps it’s of very poor quality
- and it should be
repaired/replaced].

Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.
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Written by Ronnie Tucker

U BUNTU 1 4.1 0 (R22)

B

rief list of changes in stable's
OTA-3.5

suspend
- Fixed indicator-network crash
- Fixed location settings
persistance after reboot

- Fixed some issues with mobile
carrier data not connecting when
leaving Wifi
- Fixed calendar sync
- Fixed wrong hang-up of calls
when there is a call waiting
- Fixed ubuntu-keyboard crash
- Disable upstart logging to fix
cases of reboot loops
- Fixed listing click updates for
frameworks newer than supported
on the device
- Improve location accuracy
- Fixed routing problems after
switching from Wifi to mobile
carrier data
- Fixed multiple telepathy accounts
from being created
- Fixed store scope updates
causing the scope disappearing
from favorites
- Fixed airplane mode causing
battery drain
- Fixed issues with enabling
location
- Fixed issues with non-releasing
wakelocks causing phone not to
full circle magazine #97

M EIZU LAUNCHES THE
U BUNTU MX4

popular high-end smartphone
brands in China, recognized for its
innovative and elegant product
design and for pioneering the user
centric distribution model that has
n the first of a series of launches, become the standard for several
Meizu has announced that the
Chinese manufacturers.
Ubuntu MX4, which will be sold
across Europe soon, is immediately
The Ubuntu MX4 launch also
available to developers in China.
coincides with the final months of
The move kicks off Meizu’s push
the China Mobile Ubuntu
towards strengthening the Ubuntu Developer Contest, which is
ecosystem in China, ahead of
already seeing thousands of
launching the Chinese Edition to
developers participating in onsite
its user base later this year.
and online training as well as
hackathons at various universities
Meizu is one of the most
across China.

I
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KD E P l a s m a 5

Written by Alan Ward

T

his April’s version of Kubuntu
is the first to come by default
with the new KDE desktop
manager version 5, based on the
Plasma 5 user interface toolkit.
Previously, in 1 4.1 0, two separate
desktop environments were
offered; the more classical KDE 4
for users more interested in
stability, and KDE 5 for early
adopters and testers.

the KDE project team members
have been hard at work making the
KDE desktop as a whole much
more responsive, and ironing out
the various defects that plagued
original releases of KDE 4; it
certainly seems worth testing out
the new KDE, and seeing what
progress has been made on this
front, and whether the new
Kubuntu 1 5.04 can be used today

KDE has long been known both
for its quality graphics, and for its
ease of use and configuration.
Unfortunately, version 4 was a bit
of a disappointment for many. At
the beginning, it did tend to
consume perhaps more CPU (and
GPU) processing than would be
reasonable, much RAM, and as a
result gave an impression of being
generally buggy and working
rather slowly. This scared away
many, such as myself, who
appreciated a well-drawn desktop
environment such as KDE version 3
in the past, but also get to need
some work done, quickly and on
time.

as a general purpose desktop
distribution as it has in the past.

The desktop environment was
organized in a way that users of
other operating systems would
KDE VERSIONS 3 AND 4
find familiar, with a task bar
holding an application menu, direct
The last version of Kubuntu that access links to programs, and a
came with KDE version 3 (to be
notification area – the whole
precise, 3.5) was Kubuntu 8.04,
located at the places one would
considered by many as a fairly
expect, at the bottom of the
advanced and stable desktop for
screen. Graphical elements’ design,
the time.
such as the icons, was bright and
cheerful as
well as
informative.
The icon
representing a
USB drive was
a beautiful
piece of work.
Kubuntu 8.04 actually came in
two versions, one with KDE 3.5 and
the other with the new KDE 4.0
desktop. Then, in late 2008, out
came Kubuntu 8.1 0 with KDE 4.1 as
its one and only desktop
environment.
It was not much of a success.
On the one hand, users were happy
to see the KDE project not resting

The impression we have is that
full circle magazine #97
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on the laurels earned with KDE 3,
but, on the other, the general
consensus was that version 4.0 was
not yet quite ready for general
use. Specific criticisms were
levelled at the desktop’s perceived
slowness, and the fact that some
bugs had not yet been ironed out.

of non-active activities would not
interfere with the active pane, but
run silently in the background until
that activity was activated
(brought to the front). Users could
organize their workflow across
different activities: one for work,
another for play, etc.

Perhaps if KDE 4 had been
released as beta software, still
maintaining the version 3.5
desktop as an option, critical
reception would have been better.
In their defense, the KDE project
members may have considered
that working on a single version of
their desktop manager was a
better use of limited resources.

This is a different concept than
virtual desktops -- each activity
could contain its own virtual
desktops -- although in practice
both mechanisms can be used for
the same purpose of organizing

windows.
This is also when the “Plasma”
terminology was introduced, to
refer to KDE’s user interface
technology as a whole.
The interested reader can still
access the original distribution ISO
images at http://oldreleases.ubuntu.com/releases/kub
untu/. However, it is important to
stress that these distributions are
no longer maintained. Their use
cannot be recommended in

KDE 4 introduced a new
concept of working with the
desktop. Although some elements
were distributed in much the same
way -- the taskbar, for example,
was remarkably similar -- the
desktop itself was converted from
a mere backdrop that supported
icons, to a more global work area
in which active elements, desktop
widgets, could be placed.
Furthermore, activities were
introduced. These worked as
separate desktops the user could
switch among. Program windows
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production environments, which
naturally does not preclude testing
on a spare (or virtual) computer if
so inclined. When I tested them,
Kubuntu 8.1 0 made itself
noteworthy, among other things,
by keeping one of the CPU cores
(of an Intel Core i5) pegged at near
1 00% capacity - thus generating
much heat and fan noise. This is
the type of “feature” that early
adopters criticized - and that has
been slowly solved over the
different versions.
In any case, the KDE 3 series
still lives on as the Trinity project
(https://www.trinitydesktop.org)
maintained by project members
who saw KDE 4 as a step
backwards in some areas. This just
goes to show the beauty of opensource software: if you do not
agree with the direction a specific
project is going, just fork it and roll
your own. Unfortunately, the
Trinity packages are not directly
available within the Kubuntu
repositories. For those interested,
detailed instructions on converting
your existing setup to Trinity can
be found here:
https://wiki.trinitydesktop.org/Ub
untuInstall.
contents ^
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Application and other icons
O N TO PLASMA 5
have evolved towards a flatter
Working with Plasma 5 should
not give many surprises to users
used to running KDE 4. KDE
version 4.1 4 in Kubuntu 1 4.1 0 is
much more refined -- and stable! -than the original 4.0, and the new
Plasma 5 environment seems to
draw heavily on this now mature
version of KDE 4.

The first impression we have
when running Kubuntu 1 5.04 Vivid
Vervet is that of color. The default
desktop has left the traditional
KDE world of blues, and gone
towards a more harlequin-inspired
set of colors.

lateral bar, and various dialog
windows, all share a second,
understated and smaller version of
presentation, leaving behind the
the new icon set. This mini-icon set
previous skeuomorphic tendency
is based on pure line art, in black
of icons with a 3D effect in their
graphism. This is exactly the same for informative icons and red for
alerts, on a gray background. The
tendency that is seen in Google’s
web design, Microsoft’s Windows 8 lack of details combined with a
very small base icon style can make
Metro environment, and Apple’s
IOS 7 and OS-X 1 0 Yosemite. In the for difficult reading at times.
beta versions of 1 5.04, some of the Perhaps the designers were
icons had not yet been updated, as thinking of higher resolution
is the case with Thunderbird in the viewing screens, where the thin
lines may be better rendered.
screenshot.
The new design is pervasive
across the desktop environment.
Besides the main (large) icon set
used for files, the status bar, menu
bars, the Dolphin file manager’s
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A window theme called Breeze
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replaces KDE 4’s Oxygen and
replaces the light or dark gray
gradients we know with wide,
uniform dark window bars. Widget
buttons show new OK and Cancel
buttons with revised graphics
based on thin lines, also similar in a
way to Apple’s newest offerings.
Notifications are rather lowkey, appearing briefly in the low
right-hand corner. Each individual
notification can be managed on a
granular basis: we can choose for
each action whether we prefer a
message, a sound, both or neither.
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Clicking on the notification
message gets us, in many cases, to
the relevant program to solve the
problem; for example, from an
alert concerning lacking packages,
we can run the relevant installer
directly. After installing the public
release version of Kubuntu 1 5.04,
the updater came up immediately
with a request to install a security
update. This is not quite rocket
science as far as user interface
design is concerned, but is
certainly helpful in day-to-day
system management.

The driver manager is also
there, ready to inform the user
about the availability of specific
drivers for the hardware.
Activities and virtual desktops
work in the same way as KDE 4. So
do the various types of desktop
organization (“workspace type” in
KDE terminology). KDE 5 includes
two types of workspace that can
be configured from the desktop
settings window (right click on the
desktop):

full circle magazine #97

• A “standard” desktop view, in
which no elements are actually
located on the screen.
• The “folder” view, in which the
contents of directory
/home/<username>/Desktop are
reflected on the desktop. This is
the view that best corresponds to
other operating systems.
Previously, KDE 4 also had two
further view types:
• A “newspaper” layout, that
organized windows and other
desktop widgets in columns.
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• The “netbook” view, with a main
menu that covered the entire
desktop, much like tablet and
phone user interfaces.
These seem to have
disappeared in KDE 5 for some
reason; they can no longer be
downloaded from the repositories,
and the option in System settings >
Workspace Behavior > Workspace
> Workspace Type has
disappeared. We are still not sure
whether this is just a temporary
setback that will be corrected later
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on, or a conscious decision to
simplify the number of options in
this environment.

equipped with an Intel Atom 1 .6
GHz processor, 1 GByte of RAM,
and a spinning drive.

Perhaps the most noteworthy
feature of Plasma 5 is the lack of
specific new additions. Some
changes have been made, such as
the login display manager (the new
SDDM replaced KDM), or the Baloo
file indexer replacing Nepomuk. As
for the rest, the systems settings
configuration panel, the file
manager, and other components of
the desktop environment work
much in the same way as KDE 4. In
this sense, KDE 5 can be seen more
as a continuation of KDE 4 than a
revolution. There are fewer
differences between them from a
user’s perspective than between
versions 3 and 4.

Performance of Kubuntu 1 5.04
was good on the Core i5, as
expected. The system comes up
quite sprightly, and after some
rather intense web navigation and
the use of programs, reports a

mere 1 .2 GBytes RAM occupation
(out of a total of 4 GBytes). The
dedicated nVidia graphics
processor on this laptop also helps
get the most out of KDE’s desktop
effects.
On the other hand, I
approached the small Acer with a
bit of trepidation. I had abandoned

SPEED IS IMPORTANT
As stated above, the final
releases of KDE version 4 already
gave better performance figures
than previously. This tendency is
confirmed by Plasma 5. We have
tested the new desktop on two
platforms. One was an Intel Core i5
laptop with an SSD hard drive,
while the other was one of the
original Acer Aspire netbooks,
full circle magazine #97

44

all ideas of using a complete
desktop manager with all the
graphical bells and whistles on this
particular piece of equipment; its
purview was restricted to
lightweights such as Xubuntu’s
XFCE and MATE - where it did quite
well, indeed.
Rather to my surprise, the
Kubuntu 1 5.04 (i386) software +
small Acer hardware combination
booted up in 1 minute 46 seconds.
This may seem a tad slow at first
sight, but is actually quite correct
given the age of this (rather lowrange) piece of hardware.
Obviously, boot-up times are at a
much faster 40 seconds on the
Core i5 due to the combination of
a more powerful processor and,
most of all, the SSD hard drive.
Sound and graphics work well
out of the box on the Acer, as does
WiFi. I was able to navigate the
web and even view videos on
Youtube with no hassle. Video
reproduction is a bit choppy for
any resolution over 400 pixels,
which is perhaps excusable for the
available hardware. The hardware
manager immediately came up,
and proposed the installation of
the single proprietary driver
applicable for this particular laptop
contents ^
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Kubuntu 1 5.04 Beta 1 to Beta 2,
and more bugs have been ironed
A specific tweak applied to this out in the final release to the
public. The apport bug notification
computer, that can be
recommended for computers with application had nothing to do after
slower hard drives, is to disable file setting up and booting the final
indexing. The Baloo indexer can be release, unlike both betas. Perhaps
it may be useful to remember that
configured to index only some
volumes or deactivated altogether beta versions are not finished
software releases, but must be
in the System settings > Desktop
considered as work-in-progress at
effects control panel. Otherwise,
best, and downright buggy at
the user can expect some heavy
disk usage, at least the first times worst. However, by making them
available to early adopters, more
the system is booted up. On the
Core i5, Baloo’s activity resulted in people will use the new software
one of the processor cores getting in a variety of situations and
pegged at 1 00% capacity for some experience possible bugs. By
time, as it digested the contents of reporting them to the Kubuntu or
KDE projects, as appropriate,
the hard drive.
developers can get on top of them
before the final release is offered
The overall impression is that
much attention has been given to up to the general public.
staying more-or-less within the
The beta versions of Kubuntu
general desktop design
1 5.04 did contain quite a lot of
parameters initially drawn up for
bugs. For example, the installer
KDE 4, while increasing actual
simply locked for some testers,
usability on a wider range of
while, in my case, I got a system
hardware platforms.
that went into sleep recurringly
every two minutes while the
ALL IS NOT ROSY
installer was doing its job. Once
the system was up and running,
Unfortunately, there is still
upgrading the kernel to version
some scope left for making
3.1 9 did not work well for some,
improvements. There was a
needing a reboot back into the
noticeable leap in quality from
previous version, 3.1 6.
full circle magazine #97
(Intel CPU microcode).

A noticeable quirk is that the
kwallet application reported
needing to migrate from a
previous file layout to a more
modern version. This happened to
me even when performing a fresh
install with the public release,
which was a bit weird.
Perhaps the most obvious
defect for the general user
concerns the notification area in
the menu bar. Although general
operation is similar to KDE 4’s
offering, the internal mechanisms
seem to have changed a bit under
the hood. This results in not
playing well with many external
software applications. Dropbox
works well in the background, but
with no status icon to inform the
user about its state. It is difficult to
know precisely what the program
is doing, which can be a bit of a
hassle - especially at the
beginning, just after installation,
when Dropbox needs to download
some binary blobs and index files
on the hard drive. Some versions of
Plex also seem to have problems,
refusing to start and complaining
about not being able to access the
notification area.
Some computers, such as a low-
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cost Acer AO-722 notebook, had
issues with the screen flickering
and window borders disappearing
as soon as multiple virtual
desktops were enabled. This
seems to depend on the graphical
hardware present, and can be
cured by installing specific
graphical drivers or, obviously, by
deactivating virtual desktops.
More serious was a problem in
Beta 2 that left the user looking at
a blank screen. Rebooting did not
seem to help, either. This seems to
be related to a problem with the
configuration files, that moved
from directory ~/.kde to
~/.config/kde and
~/.config/plasma. The solution
given in
https://www.kubuntuforums.net/s
howthread.php?67234-Blackscreen-with-Plasma is simply to
remove these directories (be
careful!), and reboot the computer.
This wipes out configuration items
such as WiFi networks but makes
the desktop come up once more.
Once again, let us remember
that detecting such problems is
precisely why beta versions exist.
But there do seem to have been a
lot of them in this version of
Kubuntu, most of which were
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corrected in the public release of
April 23.

To end on a more positive note,
some of us were wondering if the
-admittedly major- system
component change towards
systemd would affect system
usability. I am happy to report this
is not the case for Kubuntu 1 5.04,
at least as far as general desktop
or laptop use is concerned. I would

be more concerned from the
standpoint of server
administration, but, on the other
hand, a KDE desktop would
probably not be the system of
choice by the people concerned,
for that specific type of workload.

1 5.04: that the user experience is
just about what some of us have
been hoping for from the Kubuntu
project for some time now. We
have a nice, colorful desktop with a
lot of helpful automated actions
going on under the hood to take
the hassle out of basic systems
Aside from the minor
administration. It is safe to say that
difficulties experienced, I would
this version should gain
like to end with a general comment acceptance from users, and
on this particular version of *buntu perhaps not only among power-

users and staunch supporters of
KDE but also among the more
volatile regular desktop switchers
such as yours truly. This
distribution also impresses
favorably for its speed on low-end
and elderly computers, though it
should be stressed that in such a
case reducing the amount of
desktop effects active can help
avoid processor overload. In any
case, as usual with KDE, if a
processor with decent speed and a
fast -- preferably SSD -- hard drive
are available, the desktop
environment can make good use of
them.

Alan teaches computer science at

Escola Andorrana de Batxillerat
(high-school). He has previously
given GNU/Linux courses at the
University of Andorra and taught
GNU/Linux systems administration at
the Open University of Catalunya
(UOC).
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MY STO RY

U bu n tu /Wi n d ows D u a l Boot

Written by Roland Hunt

After downloading the Ubuntu
1 5.04 64-bit ISO from the Ubuntu
The initial install of Ubuntu
website, and the USB Media
1 4.04 went well – albeit by using an creation tool that the Ubuntu site
initial install of Ubuntu 1 0.1 0
links to, I created a USB installer
followed by an Upgrade to 1 4.04
for Ubuntu 1 5.04 and Upgrade
via the Update Manager. I set up a installed Ubuntu 1 5.04 onto the
root partition of 232.9 GB for the
Ubuntu root partition. I’m now left
Ubuntu install, a home partition of with a fully functioning
2229.2 GB for my data, a logical
Ubuntu/Windows dual-boot
partition of 4.0GB for the Linux
laptop.
swap partition, and the remaining
465.8 GB given over to a single
After the trouble of getting a
partition for Windows 8.1 Pro.
Windows/Linux dual-boot system
running, in hindsight I might have
After I got Ubuntu 1 4.04
been better off installing Windows
updated, I booted from a Windows first, and setting up the Windows
7 Ultimate DVD, installed Windows and Linux partitions from within
7, and then installed Windows 8.1
the Windows installer, and then
In January 201 4, I got an Acer
Pro from a 32GB Samsung SD card. installing Ubuntu second – to
C720 Chromebook which was my
Once I’d got Windows 8.1 Pro
ensure that everything worked
first encounter with Chrome OS,
installed and set up, I shutdown
correctly when done. However, this
even though I’d been using
the
Toshiba
laptop
for
the
night.
is the first time that I’ve run a dualChromium OS from December 27th
boot Windows/Linux system and
of 201 3. It was my first experience Then on May 3, I started up the
Toshiba laptop. Instead of being
my only previous dual-boot setup
of buying a Laptop that comes
was with Windows 8.1
with a Linux OS as standard – even greeted by the usual Grub boot
screen
with
OS
selection,
I
was
Pro/Windows 1 0 Technical Preview.
though Chrome OS isn’t a true
greeted by the Windows 8 splash
Linux Distribution. I’ve been
screen, and basically a Windows
After learning something new
running it alongside my Toshiba
about how to set up a dual-boot
laptop ever since I got it, until May laptop with an unusable set of
Ubuntu
1
4.04
partitions.
Windows/Linux system, I’m now
2, when I decided to dual-boot my
looking forward to using Ubuntu
Toshiba laptop with Ubuntu 1 4.04
fter being a Windows user
since 1 999, and even building
a custom Windows PC in 2001 , I
switched to Linux in early 2009
with OpenSuse (I can’t remember
the version number, but it was the
last release that had a paid box-set
available to purchase from
Amazon). I switched to Ubuntu
later that year with 1 0.04 LTS,
which I used for quite some time
before getting a new Windows 7
laptop in late 201 0 – which even
got upgraded to Windows 8 Pro
and then Windows 8.1 Pro albeit
with a brief three-month stint of
using Ubuntu again.

and Windows 8.1 Pro.
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again, and it might even be the kick
I need to actually start producing
content for my YouTube Channel
as there are plenty of professional
quality video editors for Linux that
might work better on the hardware
of the laptop than what Adobe
Premier Pro does in Windows.
Using the YouTube Capture App
for IOS is pretty basic and OK for
stitching together several clips.
However, using the YouTube
Creator Studio from within the
YouTube website isn’t as powerful
as proper editing on a computer
and then uploading to YouTube.
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If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org .
PLEASE NOTE: some letters may be edited for space.

Join us on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
linkedin.com/company/fullcircle-magazine
ubuntuforums.org/forum
display.php?f=270

FULL CIRCLE N EEDS YOU !

FCM#1 00
SURVEY

Without reader input
Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.

The question is:

What are your most
loved/hated flavors and
releases?
Take the quick survey and we'll
publish the results in
FCM#1 00.

See the article Writing for Full
Circle in this issue to read our
basic guidelines.

http://goo.gl/DPt2q0
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Have a look at the last page of
any issue to get the details of
where to send your
contributions.
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If you have a Linux question, email it to: misc@fullcirclemagazine.org , and
Gord will answer them in a future issue. Please include as much
information as you can about your query.

Compiled by Gord Campbell

my Nvidia GTX
Q 960HowtocanworkI getproperly
with
Ubuntu?

A

Google this: gtx 960
ubuntuforums

The first result should point to
a post which says "SOLVED". The
procedure can probably help
people with other recent Nvidia
graphics cards.

I'm remotely mounting a
Q shared
Windows 8 partition

from Ubuntu 1 4.04.2 using an
entry in fstab. When I look at the
file permissions, it looks as if I
should be able to write to the
partition. However, when I try to
write to the folder I get
"Permission denied."

A

(Thanks to MarkPhelps in
the Ubuntu Forums) Check in
Win8 to ensure that you have
disabled FastStartup -- that is NOT
the same as Fast Boot. Also, when
you leave Win8, make sure you
choose ShutDown, not Restart,
because the latter automatically

enables hibernation.

How can I have a plain
I need to mount my laptop
Q background
Q
in Xubuntu 1 5.04?
upside down. With the Nvidia

A

Q

I am setting up a new
In Settings, Desktop, there is
web/game server and want to
a drop-down called "Style."
have remote access, but we want it Select the top item, "None." The
more secure than SSH. What
line below that lets you pick the
should we do?
color for your plain desktop.

A

(Thanks to TheFu in the
Ubuntu Forums) I don't know
of anything more secure than SSH
using ssh-keys. Never allow
passwords for Internet connected
systems; that is TOTAL FAIL.
Lots of ways to lock down SSH
further:
- install fail2ban (blocks brute
force attacks)
- block all external IPs except from
the people who should have access
- use an iptables rule that slows
down access from IPs with multiple
login failures.

I have an ATI Radeon HD
Q 2400XT,
and, when I installed

Ubuntu 1 4.04, the graphics card
driver was installed automatically.
Did Ubuntu install the latest ATI
graphics driver or is it a generic
driver?

A

(Thanks to QIII in the Ubuntu
Forums) That is an older card
and it no longer enjoys Linux
support from AMD. The legacy
driver will not work with the
current version of X Server. When
you installed Ubuntu, the default
open source Radeon driver was
If you want more security with
installed -- otherwise you would
ssh, you could force two-factor
not be seeing anything. That is the
authentication with something like driver you will need to use.
Google-authenticator or Ubikey.
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331 .1 1 3 drivers my games perform
well but I cannot rotate my screen.

A

Run Nvidia X Server Settings.
Select "X Server Display
Configuration" on the left. The
fourth item on the right is
"orientation".

I added LibreOffice to a fresh
Q install
of Xubuntu 1 5.04, but
the spell check did not work.

A

Run Language Support and
follow its suggestion to
complete the installation. Restart
LibreOffice.

I am interested in donating
Q some
old computers.

A

(Thanks to Veddox in the
Ubuntu Forums) That is a
good idea, if they are still
reasonably good. Speaking as a
teacher at a school in Africa, we
sometimes get old computers
donated by somebody in the West.
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A few are still usable, but all too
often they have about 1 28MB
RAM, broken touchpads and an
Intel Pentium from 1 999. I'm sure
the people who send these out do
so with the best intent, but they
don't help, we can't do anything
with them. In short: don't give
away junk. (If they have enough
power to run Windows 7
reasonably smoothly, or Ubuntu or
Linux Mint, they are very much
welcome. But if you can't even
start AbiWord on them without
crashing them, no thank you!)

TOP QUESTIONS AT
ASKUBUNTU
* How is 'rm -rf /' able to delete all
files in the system?
http://goo.gl/z3bbEn
* What does this 'apt-get remove'
instruction do?
http://goo.gl/UO621 J
* How can I create a video file
from a set of jpg images?
http://goo.gl/Fdspz8
* How do I prevent one user in
particular from accessing my home
directory?

http://goo.gl/M7qOpi
* "mv file" and now it's missing
http://goo.gl/qSBKH2
* Can I emulate graphical DOS
applications inside a TTY?
http://goo.gl/rtO7HF
* How does Ubuntu know the
make and model of my laptop?
http://goo.gl/ZrQcWS

computer? Remote desktop host
(x1 1 vnc) and client (KRDC), file
server (samba) and print server,
web browser (Chrome), media
player (VLC), productivity
applications (LibreOffice), webcam
recording (guvcview), and system
monitor (conky). Everything
worked just fine. It felt a bit slower
than Xubuntu on the same
computer, but not by much.

the last issue of FCM.)
I plugged in my Brother laser
printer, and eventually got it
shared. The trick: in Printers,
Server Settings, enable "Publish
shared printers connected to this
system."
Six years ago, this netbook was
the slowest computer on the
market, so I'm not planning to
make heavy use of it. Even so, with
Mate it is a usable ultra-portable,
small file server or even a remote
camera.

When you start Mate, it has
* How to install Visual Studio Code panels at the top and bottom of
on Ubuntu?
the screen. With the tiny screen of
http://goo.gl/pl0Gxw
the netbook, only 600 pixels high,
one panel had to go. A few minutes
* How can I merge files on a line by of work did the job, although there
On the other hand, the
line basis?
is still room for improvement. (I
advantages over Xubuntu were
http://goo.gl/3sRV81
lost network manager and the
very limited.
volume control in the shuffle, but
they are both available in Settings.)

TIPS AND TECHNIQUES

After installing Synaptic
Package Manager, I searched for
buntu Mate is now an official "samba" and installed everything
community distribution in the which looked relevant. Five
minutes later, I had a shared folder
Ubuntu family. I have an Acer
Aspire One netbook which wasn't which allowed everybody to read
and write files. (This was the area
up to the task of running Ubuntu
Kylin, and Mate has a reputation of where Mate had an advantage over
Xubuntu.) The netbook isn't very
being fairly lightweight, so I
powerful, but it has a 1 60 GB hard
decided to have a go.
drive, which is enough to be useful
for backing up current projects. (I
What do I want from a
may even set up Own Cloud, as per
full circle magazine #97
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A new member of the family

U

Gord had a long career in the

computer industry, then retired for
several years. More recently, he
somehow found himself "The IT Guy"
at a 1 5-person accounting firm in
downtown Toronto.
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S e c u ri t y

Written by Kevin O'Brien

SSH O pti on s, Port F WD SSH & KeepAlives

works by allocating a socket to
listen to port on the local side,
optionally bound to the specified
bind_address.
-p : Port to connect to on the
remote host. This can be specified
on a per-host basis in the
configuration file.
-R : Specifies that the given port on
the remote (server) host is to be
forwarded to the given host and
port on the local side. This works
-1 : Forces the connection to use
SSH v.1 protocol only. The question by allocating a socket to listen to
port on the remote side, and
here is why would you want to do
whenever a connection is made to
that if you have SSH v.2 available.
this port, the connection is
It is a real improvement, after all.
forwarded over the secure
-2 : Forces the connection to use
channel, and a connection is made
SSH v.2 protocol only.
to host port hostport from the
-4 : Forces ssh to use IPv4
local machine.
addresses only.
-v : Verbose mode. This shows all
-6 : Forces ssh to use IPv6
commands and replies, and is
addresses only.
useful for debugging.
-b : Bind address. Useful for
-W : Requests that standard input
machines that have two IP
and output on the client be
addresses, such as systems with
forwarded to host on port over the
two NICs. This tells SSH which IP
secure channel. Works with v.2
address on the local machine to
only.
use for the connection.
-L : Specifies that the given port on -X : Enables X1 1 forwarding. But
note that this can open a
the local (client) host is to be
vulnerability.
forwarded to the given host and
port on the remote side. This
full circle magazine #97
he ssh command has a number
of options, and I don’t plan to
cover all of them. Even the SSH
documentation warns against the
use of some of them, suggesting
they are only for real experts. But I
want to mention the ones that I
think you will find important.
These options take the form of
switches in the command:

PORT FORWARDING
One of the handy things you
can do, and something useful for
tunneling. is port forwarding over
SSH. The basic idea is to connect
via ssh to a remote machine, and
ask it to send something to a
specific port other than the
default port. The basic way you do
this is to use the SSH command
with the appropriate flags, -L and
-R, which, not surprisingly, stand
for Local and Remote. You need to
specify the port you want to use,
and what will be forwarded to it.
• Local Port Forwarding – This
takes a port on your local machine
and forwards it to a specified port
on the server. So you can make a
request on a local port like 7280 on
address 1 27.0.0.1 , and your SSH
client would intercept that call and
send it to port 1 1 9 on the server.
Then you would have a secure
connection to get whatever port
1 1 9 is configured to serve
(typically Usenet traffic, but this is
just an example). So you use this to
configure your newsgroup client to
securely grab messages from a
public server, assuming it allows
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SSH connections.
• Remote Port Forwarding – This
is the reverse of Local Port
Forwarding. Here, the idea is to
specify a port on the remote
server and have it forwarded to
your local server. This is not very
common, and you may never need
to do this. Essentially, all traffic
coming in to the server on the
specified port would then be
forwarded to your local machine.
• Dynamic Port Forwarding – This
creates a SOCKS proxy and is not
restricted to one port or one type
of traffic.

LOCAL PORT FORWARDING
Suppose you are at work (or
school), and you just cannot bear
to miss out on your Facebook
stream. But there’s a filter
stopping you from accessing the
site. However, for the sake of
argument, you could create an SSH
connection to a server outside the
network (which could be your
computer at home). You could then
do something clever using Local
Port Forwarding. Create a
connection as follows:
contents ^
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In that case, SSH Port Forwarding
would be a very useful way to
connect sites to exchange data.
Now, your home machine does You might have a database server
need to have a public IP address, or that employees might need to
you would need to set up your
connect to, and don’t want that
router to forward the traffic, for
traffic flowing through the
this to get through.
Internet unsecured. Or perhaps
you have set up a server for
Once you have done this, you
yourself, such as OwnCloud, and it
would open your browser and set is in a remote hosting center.
it to go to http://localhost:7280,
Creating an SSH connection and
and traffic would then flow to your using Port Forwarding might make
home machine, and from there to your data a lot more secure.
Facebook. You can now browse to
your heart’s content on your
LIMITATIONS
Facebook stream. Of course, this
also illustrates why network
There are a few things you need
admins might want to shut down
watch out for. One is that not all
SSH traffic, which they might do by to
ports may be available to you. If
blocking any outbound traffic
you are in a Unix-like environment,
going to port 22 (the default SSH
for instance, port 1 024 and all
port). And you could then try
below that can only be used
changing the default port on your ports
by root. But any port above 1 024
home SSH server to something
should be usable by a user with
other than port 22, and then the
normal privileges as long as no one
admins could do deep packet
else is already using it.
inspection, and so on.
ssh -L 7280:facebook.com:80
address of home machine

But SSH Port Forwarding is not
just a matter of a security breach in
the making, it can be used very
legitimately in a number of
situations. For example, you have a
company with a number of
geographically dispersed locations.

The other thing you need to
remember is that if the connection
is dropped the port forwarding is
gone. And, in general, TCP
connections are configured to
close after a period of inactivity,
and on some firewalls that can be
full circle magazine #97

as little as 300 seconds (5 minutes).
This can be controlled by a rule (or
perhaps more than one) in your
iptables, or directly by
/proc/sys/net/ipv4/tcp_keepalive_t
ime. But, if you want a persistent
connection, you need to use a
Keep Alive.

For just you, edit ~/.ssh/config,
and add the above code to it.

ServerAliveInterval, specifies
how often a null packet should be
sent to the server to keep the
connection alive. However,
sometimes the server may go off
or drop the connection, so the
KEEP ALIVES
second line specifies how many
times you should send a packet
There are two, basically. One is without getting a response. The
the TCP Keep Alive, which is simple setting I have shown will send a
but spoofable, and the other is the packet, and if no response is
SSH keepalive, also called
received, it will send a second
serveralive. Serveralive messages
packet 300 seconds later. If no
travel through the encrypted
response is received to the second
connection between you and the
consecutive packet the connection
server, and thus cannot be
will be dropped by your client.
spoofed. Assuming security is your
reason for creating SSH
On Windows, using PuTTY,
connections, then it would be more there is a good explanation at
secure to use serveralive
http://blog.hazaveh.net/201 3/1 0/k
messages, though I expect using
eep-ssh-session-alive-in-putty/, but
TCP keepalives is far from the
essentially you go to Connection,
worst thing that could happen. In
and then on the right under
Linux, you can set this up either for Sending ofnull packets to keep
everyone (if you have root
session active, you can set Seconds
privileges), or just for yourself, by between keepalives (0 to turn off)
editing the appropriate config file. to 300 seconds to get a similar
result.
For everyone – edit
/etc/ssh/ssh_config and insert:
Once you understand Port
Host *
Forwarding and Keepalives, you
ServerAliveInterval 300
are most of the way to tunneling.
ServerAliveCountMax 2
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Th i s Wa r O f M i n e

Written by Oscar Rivera

ost of the time when we play
a war game, we are either a
foot soldier in a first-person
shooter, we drive a combat vehicle
(like in War Thunder reviewed in
FCM#93), or we are the prime
decision-maker in war strategy
games like Empire: Total War. The
video-game This War of Mine fits
none of those scenarios. In fact, in
This War of Mine, you are not really
even fighting a specific enemy perse, except perhaps for the war
itself. Erase every idea you may
have about a war game, and
instead imagine yourself in any war
that's ever been – as an ordinary
civilian trying to stay alive. This
War of Mine is a war, survival &
strategy game where you're just
trying to stay alive as a civilian in a
war that you didn't ask for and you
wish would just end. “In war, not
everybody is a soldier” is the quote
used to promote the indie game
This War of Mine. That phrase
about sums it up as to the content
of the game. This War of Mine was
released for Linux, Mac & Windows
on November 201 4 by Polandbased 1 1 -Bit Studios.

G AME SYNOPSIS
This War of Mine depicts the
gruesome reality of the horrors
that the average person must
endure when a war happens to
knock at your front door. It's most
certainly a war-survival game, but
it is also definitely a strategy game
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where you must plan out your
course of action from the get-go. I
will add right now that This War of
Mine is NOT for the faint of heart.
It's not your typical combat game
where you'll see bloody, gory
graphics, but instead the warning
I've issued is due to the moral
choices you'll be forced to make in
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order to survive and the
unimaginable events you'll witness
before the war ends. I've never had
to endure a war first-hand but
playing this game reminded me of
when I was reading Viktor Frankl's
account of surviving in a WWII
concentration camp in his book
Man's Search for Meaning. You will
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definitely need to make some
tough choices in this game – which
is one of the reasons it's gotten
such rave reviews since its release.
The game itself is very well
polished and, out of all indie
games I've played in recent times,
it's without a doubt the most
accomplished and best all round. I
have not encountered any bugs
yet, and, from what I've read in
various forums, I don't expect to
find any bugs at all.

PLAYING THE GAME
You start out the game with a
team of survivors, usually three or
four, and, as the days pass, there's
a chance that at least one other

person will knock at your door and
ask to join you; it's completely up
to you whether you accept the
other person or leave them outside
to fend for themselves. Not having
a tutorial at all, the first couple of
times you play, it may be a sort of
trial-and-error learning experience,
but, after a couple of tries, you
should have a handle on what
you're doing and begin to plan a
well adjusted strategy. My first
time playing I actually made it to
nine days before my first character
was killed.
The only, and I do mean the
ONLY, downside to this game is
that you don't have the luxury of
saving your progress like you do in
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other games. The only options
available to you when you play are
“Continue” or “Another Try” which
should be self-explanatory.

materials. In order to have my
players well rested, I like to build
two beds for them, though at first
one will suffice. You may also want
to build a metal workshop so you
Your survivors are found in a
can build your crowbar and other
decrepit building that has plenty of metal needs. Ultimately, all you
items scattered around to get you really need to survive is rest (on a
started. The first order of business bed is preferable), food, water, and
is to send your survivors to
meds. If you have a character with
scavenge whatever they can find in addictions such as coffee or
your building. Unfortunately, there cigarettes, you will also need to
will be places that will be
provide those, otherwise your
unreachable at first until you
character will become depressed
obtain either a lock-pick or a
and end up broken, catatonic,
crowbar, both of which can be
and/or leave your team.
built, or traded from someone
else. Having gathered as much as
Building a heater is essential
you can, you then face the choice
when winter comes, an animal
of what to build with your
catcher will help you catch rats to
eat, a distillery will provide you
with alcohol for trading, and the
list goes on. In the daytime, while
staying in your building, it's your
job and responsibility to upgrade
your living arrangements, cook
food, gather water, make alcohol,
upgrade your tools, grow herbs,
make cigarettes, meds, etc. At
night, you send one of your
survivors out to the fictional city of
Pogoren so they can scavenge for
more items. The next day is all
about further upgrading your
living quarters with the items you
have found at night in other
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buildings around the city. The real
danger shows its ugly face at night
when you're scavenging around
the city. Some places are relatively
safe to visit; however, others are
not. There are places you can go to
where armed assailants are willing
to kill you at first sight. Other
places have inhabitants still
occupying their original abode, and
may or may not be willing to trade
with you. Regardless of whether
the trade happens, if you happen
to take any items (especially food
or meds) that belong to them, your
survivors will become sad because
they know that those people's
lives might have been shortened
thanks to you robbing them.
However, taking items from
criminals is OK and has no negative
feelings associated with it.

PLAYABLE CHARACTERS

and your whole team benefits from
him in that he uses less resources
when cooking food, collecting
There are different
permutations of people with whom rainwater, distilling alcohol, or
you can start out the game. There producing meds or cigarettes.
Katia is good at bargaining, and
are a total of 1 0 playable
characters, and each has strengths whenever you have to barter with
someone, she'll get you the best
and weaknesses. Some
combinations of people are better deal. However, for scavenging, the
best is no doubt Marko as he can
than others depending on what
carry up to 1 5 items in his
strategic approach you will take.
For example, Bruno is a good cook, backpack, and he’s not slowed
down when the load is heavy.

THE WAR IS O VER
You eventually beat the game
by surviving anywhere between 2050 days. I've heard of some people
beating after only 22 days, and yet
there are others who had to reach
47 before beating it. There are
different scenarios played out as
your game progresses which are
decided depending on your ingame choices as well as just pure

For defense there are a number
of weapons that can be used
throughout the game, such as
knives, crowbars, shotguns, etc.
What I've found best is not to kill
unless you absolutely have to, and,
if you do, it's best to kill with a
knife or another silent weapon
instead of something loud like a
shotgun that will alert other
criminals of your whereabouts.
full circle magazine #97
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random luck. For example, your
game could begin in the middle of
winter, which would make you
start the game already owning at
least one heater. On the flip-side,
your game could begin before
winter approaches which means
you have no heater but when
winter arrives you must build a
heater, otherwise you'll freeze to
death... literally. I've had a couple
of characters actually freeze to
death. I've also had characters die
of hunger, illness, or even
untreated injuries. The quick way
to die is getting killed while
scavenging throughout the city.
Your characters are also prone to
getting depressed and
contemplating suicide if times are

really tough. In short, it is as if you
really are trying to survive a war
that just landed in your backyard.
Like I've previously stated, it is the
decisions you make that ultimately
determine how likely it is that your
characters will survive in this wartorn state.

www.humblebundle.com. The
download and installation is pretty
straightforward. I got mine from
Steam, and, after purchasing it, I
simply waited a few minutes for
Steam to download and install it in
the background while I was busy
doing other things. The game
currently sells for $1 9.99, but
often it is on sale for lower than
that. I got lucky and paid half off
the full price when I got it.

CONCLUSION

In short, this is by far one of the
most entertaining & innovative
games I've had the pleasure of
playing in a long time. I really
enjoyed playing This War of Mine.
The game-play is unique and keeps
you engaged. The way it stirs up
I NSTALLING THIS WAR OF
emotions within you is something
M INE
I've not experienced from a video
game before. The charcoal-stylized
You can install This War of Mine Minimum Specs
graphics intertwined with
in one of several ways. If you want These are the minimum
authentic street art pieces made
all of your proceeds to go to 1 1 Bit- specifications as taken from the
by artists from around the world
Studios, then you can get the game official game website:
(included only if you buy the War
from the 1 1 bitstudios website.
Child Charity DLC) keeps the game
• OS: Ubuntu 1 2.04
Otherwise, you can get it from
uncomfortably gloomy. The eerie
• Processor: Intel Core 2 Duo 2.4
either Steam or
and depressing soundtrack
GHz, AMD Athlon X2 2.8 GHz
unmistakably enhances the uneasy
• Memory: 2 GB RAM
feeling that permeates throughout
• Graphics card: Geforce 9600 GS,
Radeon HD4000, Shader Model 3.0, the game. I strongly recommend
this game.
51 2 MB RAM

My Custom-made Gaming Rig:
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• AMD FX-61 00 3.3GHz CPU
(overclocked to 3.5GHz)
• Asus M5A97-EVO motherboard
• Gigabyte Windforce GeForce GTX
960 graphics card with 346.59
proprietary driver
• 8GB of Kingston Hyper X RAM &
1 TB Seagate Barracuda hard drive
Ubuntu 1 4.04.2 LTS with Unity
desktop
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Oscar graduated from CSUN, is a

Music Director/Teacher, beta tester,
Wikipedia editor, and Ubuntu
Forums contributor. You can contact
him via: www.gplus.to/7bluehand or
email: www.7bluehand@gmail.com
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